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ACADEMIC/PROFESSIONAL BACKGROUND

EDUCATIONAL BACKGROUND
▸ 1992 Master of Fine Arts, Graphic Design, with honors, Savannah College of Art and Design
▸ 1987 Bachelor of Fine Arts, Graphic Design, with honors, Louisiana Tech University
▸ 1987 International Studies Certificate, Sophia University, Tokyo, Japan

UNIVERSITY EXPERIENCE
▸ 2022–present Texas A&M University-Corpus Christi, Assistant Professor
▸ 2013–2022 Old Dominion University, Associate Professor (2019), Graphic Design, (tenured 2019)
▸ 2012–2013 Old Dominion University, Adjunct Instructor, Graphic Design
▸ 1992–2012 Texas State University-San Marcos, Professor (2003), Communication Design, (tenured 1998)

RELEVANT PROFESSIONAL EXPERIENCE
▸ 2012–present Designer | Illustrator | Partner, R-N-R Showprint, Norfolk, VA
▸ 1990–present Designer | Illustrator | Consultant (Savannah, GA / Austin, TX)
▸ 1998–present Designer | Typographer | Partner, White Gas Design, San Marcos, TX
▸ 1997–1999 Technology Consultant, Austin, TX
▸ 1989–1991 Art Director, Brooks Pollard Advertising, Little Rock, AR
▸ 1987–1989 Production Artist | Junior Art Director, A. Richard Johnson, Nashville, TN

UNIVERSITY TEACHING

COURSES TAUGHT

Texas A&M University-Corpus Christi

2022 Courses taught
Fall 2022
▸ Grds 1301 (2 sections)
Spring 2023
▸ Grds 1302 (2 sections)

Old Dominion University

2021–2022 Courses taught
Spring 2022
▸ GDES 365, Basic Type (1 section)
▸ GDES 376, Typographic Design (1 section)
▸ GDES 377, Illustrative Design (1 section)
Fall 2021
▸ GDES 371, Design Concepts (2 sections)

2020–2021 Courses taught
Fall 2019
▸ GDES 371, Design Concepts (synchronous web delivery) (2 sections)
Spring 2021
▸ GDES 365, Basic Type (synchronous web delivery) (1 section)



▸ GDES 472, Package Design (synchronous web delivery) (1 section)
▸ GDES 475, Editorial Design (synchronous web delivery) (1 section)

2019–2020 Courses taught
Fall 2019
▸ ArtS 371, Design Concepts (2 sections)
Spring 2020
▸ Research/Development leave

2018–2019 Courses taught
Spring 2019
▸ ArtS 370, Basic Type (1 section)
▸ ArtS 395, Package Design (1 section)
▸ ArtS 475, Editorial Design (1 section)
Fall 2018
▸ ArtS 371, Design Concepts (2 sections)

2017–2018 Courses taught
Summer 2018
▸ ArtS 395, Graphic Styles
Spring 2018
▸ ArtS 370, Basic Type (1 section)
▸ ArtS 395, Package Design (1 section) 
Fall 2017
▸ ArtS 371, Design Concepts (2 sections)

2016–2017 Courses taught
Summer 2017
▸ ArtS 395, Graphic Styles 
Spring 2017
▸ ArtS 401, Graphic Design Portfolio (1 sections)
▸ ArtS 395, Package Design (1 section)
▸ ArtS 372, Design Systems (1 section) 
Fall 2016
▸ ArtS 371, Design Concepts (2 sections)
▸ ArtS 497, Tutorials (2 students)

2015–2016 Courses taught
Summer 2016
▸ ArtS 395, Graphic Styles 
Spring 2016
▸ ArtS 370, Basic Type (1 section)
▸ ArtS 475, Editorial Design (1 section)
Fall 2015
▸ ArtS 371, Design Concepts (2 sections)
▸ ArtS 497, Tutorial /Honors (1 students)

2014–2015 Courses taught
Summer 2015
▸ ArtS 370, Basic Type 
Spring 2015
▸ ArtS 370, Basic Type (2 sections)
▸ ArtS 395, Package Design
Fall 2014
▸ ArtS 271,Introduction to Graphic Design
▸ ArtS 371, Design Concepts

2013–2014 Courses taught
Summer 2014
▸ ArtS 370, Basic Type



Spring 2014
▸ ArtS 370, Basic Type
▸ ArtS 376, Typographic Design
▸ ArtS 401, Graphic Design Portfolio
Fall 2013
▸ ArtS 271,Introduction to Graphic Design
▸ ArtS 371, Design Concepts

2012–2013 Courses taught
Spring 2013
▸ ArtS 122A, Introduction to the Visual Arts
▸ ArtS 395, Editorial Design
Fall 2012
▸ ArtS 371, Graphic Design 3 

Texas State University–San Marcos

1992–2012 Courses taught
▸ ArtC 4316, Book Design 
▸ ArtC 4315, Senior Portfolio
▸ ArtC 4315C, Organized special problems in branding and identity development
▸ ArtC 4315C, Organized special problems in interactive digital media
▸ ArtC 4313, Special Problems Course
▸ ArtC 4311, Digital Illustration
▸ ArtC 4310, Communication Design Practicuum
▸ ArtC 4000, Senior Exit Review
▸ ArtC 3320, Advanced Typography
▸ ArtC 3308, Multimedia II
▸ ArtC 4305, Typographic Design 
▸ ArtC 4000, Senior Exit Review 
▸ ArtC 3320, Advanced Typography
▸ ArtC 3307, Multimedia I
▸ ArtC 3301, Art Direction I
▸ ArtC 2303, Foundation III, Basic Typography
▸ ArtC 1302, Communication Design Foundations II, Introduction to Digital Imaging
▸ ArtC 1301, Communication Design Foundations I, Introduction to Communication Design
▸ ArtC 5313, Communication Design Special Problems

COURSES PREPARED AND CURRICULUM DEVELOPMENT

Texas A&M University–Corpus Christi
▸ GRDS 1301, Introduction to Graphic Design
▸ GRDS 1302, Typography 1

Old Dominion University
▸ ArtS 122A, Introduction to the Visual Arts
▸ ArtS 271, Introduction to Graphic Design
▸ ArtS 370, Basic Typography
▸ ArtS 371, Design Concepts
▸ ArtS 376, Typographic Design
▸ ArtS 395, Package Design
▸ ArtS 395, Graphic Styles
▸ ArtS 475, Editorial Design
▸ ArtS 401, Graphic Design Portfolio
▸ GDES 376, Typographic Design
▸ GDES 376, Illustrative Design

Texas State University-San Marcos
As co-author of the Communication Design (ComDes) curriculum implemented with the conversion to the 

major 1996, I had a significant role in the creation of all the courses in the curriculum at that time, including:



▸ ArtC 1301, ComDes Foundation I, Introduction to Communication Design
▸ ArtC 1302, ComDes Foundation II, Introduction to Digital Imaging
▸ ArtC 2303, ComDes Foundation III, Basic Typography
▸ ArtC 2304, ComDes Foundation IV, Design Concepts
▸ ArtC 3301, Art Direction I
▸ ArtC 3303, Corporate/Package Identity
▸ ArtC 3304, Corporate Marketing Materials
▸ ArtC 3307, Multimedia I
▸ ArtC 3310, Illustration
▸ ArtC 3316, History of ComDes
▸ ArtC 4000, Senior Exit Review
▸ ArtC 4302, Art Direction II
▸ ArtC 4305, Typographic Design
▸ ArtC 4308, Multimedia II (Digital media/web)
▸ ArtC 4309, Multimedia III (Digital media/web)
▸ ArtC 4310, ComDes Practicum
▸ ArtC 4311, Digital Illustration
▸ ArtC 4313, ComDes Special Problems

CURRICULUM DEVELOPMENT

Texas A&M University–Corpus Christi
▸ Restructured GRDS 1301, Introduction to Graphic Design
▸ Restructured GRDS 1302, Typography 1

Old Dominion University

Spring 2022
▸ Restructured GDES 376 under new catalog description.
▸ Restructured GDES 377 under new catalog description.

Spring 2021
▸ Restructured and converted GDES 365 course materials for online delivery.
▸ Restructured and converted GDES 472 course materials for online delivery.
▸ Restructured and converted GDES 475 course materials for online delivery.

Fall 2020
▸ Restructured and converted GDES 371 course materials for online delivery.

2018–2020
▸ Coauthored SCHEV proposal for the conversion of the current concentration in Graphic Design to a stand-

alone B.F.A. in Graphic Design.

Fall 2014–Present
▸ ODU Graphic Design Online Tumblr portfolio. In collaboration with Assistant Professor, Ivanete Blanco,  

I maintain and contributed to an online portfolio of student design work produced at ODU as a resource for 
current and prospective students.

< http://odu-graphicdesign.tumblr.com/>

Spring 2014–Present
▸ Online Teaching Visual Archive: I maintain and update an extensive Pinterest page which I use in conjunction 

with lecture materials and as a focused reference resource for the particular projects underway in my courses. < 
http://www.pinterest.com/revrantdesign/>

Spring 2014–Present
▸ Online Graphic Design Resource List: I maintain and update an extensive listing of design firms, organizations 

and publications as well as competitions and specialized sites and blogs on blackboard for students in all my 
courses.

Fall 2013–Present
▸ A Graphic Design Creative Processes Handbook: In collaboration with Assistant Professor, Ivanete Blanco, 

authored A Graphic Design Creative Processes Handbook. The handbook (43 pages) describes the desired 
outcomes of the different stages of work created in class, the criteria which may be evaluated in grading these 



outcomes, and thoroughly breaks down the creative process from the research stage all the way to the final 
production of a design product. An appendix at the end of the document includes samples for each stage of the 
process as well as a recommended supply list. 

2016–2017
▸ Coauthored revised University proposal for the conversion of the current concentration in Graphic Design to a 

stand-alone B.F.A. in Graphic Design.
▸ Designed, administered, and evaluated the test of skills delivered as a part of the 2017 Graphic Design 

continuance portfolio process.

2015–2016

Spring 2016 Curriculum proposal
▸ Authored proposal for the conversion of the current concentration in Graphic Design to a stand-alone B.F.A. in 

Graphic Design.
▸ Designed the test of skills delivered as a part of the 2016 Graphic Design continuance portfolio process.

2014–2015

Fall 2015
▸ Course Development: Developed proposal for a Graphic Design topics course, Graphic Styles, which will be 

offered in Summer 2016.

Spring 2015 Course Developed
▸ Course Development: Established Package Design as a topics course in the Graphic Design curriculum.
▸ Designed the test of skills delivered as a part of the 2015 Graphic Design continuance portfolio process.

Texas State University–San Marcos

2011–2012 | 2003–2004
▸ Coordinated all aspects of the ComDes foundations typography courses.

1998–2012
▸ Authored and edited the ComDes policies and procedures handbook.

2005
▸ Coordinated comprehensive review of the ComDes Foundations courses ArtC 1302 and ArtC 2303.
▸ Developed course outcomes for courses ArtC 1301, 1302, 2303, 4314c, and 4000.

2002
▸ Developed ArtC 4316, a new upper division course in book design.

2001
▸ Developed ArtC 4315, a new upper division course in portfolio presentation and self-promotion.
▸ Developed ArtC 3320, a new upper division course in advanced typography.

1999
▸ Developed ArtC 4000, a new upper division course, Senior Exit Review.

1994–1996
▸ Co-authored complete rewrite of the ComDes curriculum. Developed all courses in the curriculum, initiated 

degree program name change, developed and negotiated institutional equivalencies, etc.

1995
▸ Developed a new upper division course in advanced typography under Special Problems number Art 4363.
▸ Developed a new upper division course in interactive multimedia under Special Problems number Art 4363.

1993
▸ Developed a new upper division course, Introduction to Computer Imaging under Special Problems number 

Art 4363.

1992
▸ Developed Art 2366, Basic Typography, a new foundations course.
▸ Developed Art 3311, Advertising Design I, a new upper division course.

TEACHING ACTIVITIES



Old Dominion University

Routine activities and responsibilities
The following student advisory tasks and responsibilities are a routine and recurring part of my responsibilities 

as a teacher. Less routine activities or accomplishments are listed by year in the following section.

2012–Present
▸ Provided career counseling and assisted in placement of graduates.
▸ Advised students preparing for job and internship interviews.
▸ Advised and assisted students in making contact with alumni and professionals locally, nationally, and 

internationally.
▸ Provided counseling for students applying to the graphic design program.
▸ Supervised students preparing competition entries (specific competitions listed by year).
▸ Instructed students in the use of production studio equipment.
▸ Assisted students with large scale printing in the production studio. 

2020–2021
▸ Assisted students preparing for: Addys, Richmond Ad Club, National Student Show, AIGA Blue Ridge Annual 

Design [flux], Adobe Design Achievement Awards, CA design and typography annuals, GLITCH National 
Student Design Competition.

2019–2020
▸ Assisted students preparing for: Addys, Richmond Ad Club, National Student Show, AIGA Blue Ridge Annual 

Design [flux], Adobe Design Achievement Awards, CA design and typography annuals, GLITCH National 
Student Design Competition.

2018–2019
▸ Assisted students preparing for: Addys, Richmond Ad Club, National Student Show, AIGA Blue Ridge Annual 

Design [flux], Adobe Design Achievement Awards, CA design and typography annuals, GLITCH National 
Student Design Competition.

2017–2018
▸ Assisted students preparing for: Addys, Richmond Ad Club, National Student Show, AIGA Blue Ridge Annual 

Design [flux], Adobe Design Achievement Awards, CA design and typography annuals

2016–2017
▸ Assisted students preparing for: Addys, Richmond Ad Club, National Student Show, AIGA Blue Ridge Annual 

Design [flux], Adobe Design Achievement Awards, CA design and typography annuals.

2015–2016
▸ Assisted students preparing for: Addys, Richmond Ad Club, National Student Show, AIGA Blue Ridge Annual 

Design [flux], Adobe Design Achievement Awards, CA design and typography annuals.

2014–2015
▸ Assisted students preparing for: Addys, Richmond Ad Club, National Student Show, AIGA Blue Ridge Annual 

Design [flux], Adobe Design Achievement Awards, CA design annual.
▸ Type specimen: Continued development of the specimen book.

2013–2021
▸ Type specimen: Compiled and designed a 43 page specimen book which provides a basic visual reference as 

well as a basic guide to the interpretation of typographic style. This document is not meant in its current state 
to be a work of original scholarship, but rather a helpful compilation of common knowledge for students in my 
courses in a form unavailable in current textbooks.

Other activities

2016
▸ With Ivanete Blanco, arranged and hosted campus visit by Rolando Murillo, San Antonio-based senior 

designer with HEB . In the classroom, Rolando participated in critiques, and reviewed portfolio work. He also 
delivered a well attended evening lecture and Q&A session.

Texas State University–San Marcos (selected)

Routine activities and responsibilities, 1992–2012



▸ Provided career counseling and assisted in placement of graduates.
▸ Advised advanced students preparing for job interviews.
▸ Advised lower-division students preparing for internship interviews.
▸ Advised and assisted students in making contact with alumni locally, nationally, and internationally.
▸ Provided counseling for incoming ComDes majors.
▸ Advised ComDes majors enrolling in all sessions. 

From 1994 until roughly 2000, ComDes faculty advised all majors, 50–80 majors per semester. 
▸ Supervised or assisted in portfolio development for ComDes majors graduating in all sessions—outside the 

current portfolio course system.
▸ Supervised students preparing competition entries. 

The ComDes program at TXST has always been committed to the benefits of exposing the students to creative 
competition, and my typical year brings preparation for: the Art Director’s Club of Houston, the Creative 
Summit, the Austin, San Antonio, Dallas, and Houston Addys, the One Show student competition, New York 
Type Directors’ Club, Graphis New Talent Annual, 
 and CMYK student competitions.

▸ Assisted students applying for San Antonio, Austin Addy, Alumni and departmental scholarships.
▸ Advised students preparing materials for graduate school applications.
▸ Instructed students in the use of production studio equipment.
▸ Assisted students with large scale printing in the production studio.
▸ Assisted students in execution and construction of portfolios, portfolio books, and portfolio materials.
▸ Assisted students applying for internal and external scholarships.
▸ Updated library of digital portfolios for all ComDes graduates.
▸ Consistently attended design and advertising conferences and awards ceremonies with students in all major 

markets in Texas.
▸ Organized student tours of local vendors and museums such as: the rare books collection of the Ransom 

Humanities Research Center at the University of Texas, The Museum Of Printing History, Houston, Texas, 
BookLab II, San Marcos, Texas.

▸ Organized guest lecturers in my courses from the San Antonio, Austin, Dallas, and Houston markets, 
including: art directors, graphic designers, illustrators, digital media designers, as well as professionals 
representing account service, production, video editing, copywriting, and industry vendors. 

2009
▸ Co-organizer, The 502 Pick ‘n Pull, a student work review and competition. 

Over 30 alumni reviewed the work of 82 students from all levels of the program. 30 pieces were selected for the 
Pick ‘n Pull, in which the students observed reviewers debating and discussing the work in order to select five 
final pieces for cash awards.

2001
▸ Developed program-wide essential skill sets for imaging and page layout applications for ArtC 1302, 

Introduction to Computer Imaging.
▸ Converted all lecture materials for ArtC 2303 to digital presentation format.
▸ Began digital archive of ComDes student work samples and professional work samples for each course in the 

curriculum.

STUDENT RECOGNITION AND AWARDS
Since 1992, the following organizations and publications have recognized students for projects created in classes 

under my direct instruction.

Old Dominion University
▸ 2023 AIGA Blue Ridge’s Annual Flux Student Design Competition (Frederick, MD): Juried, National (All \

finalists: Noelle Jessup, Logan Workman)
▸ 2022 Innovation Center for Design Excellence (ICDE) design competition: Juried, National (Silver medal)
▸ 2022 American Advertising Federation District 3 Addys: Juried, Regional (Silver medal)
▸ 2022 American Advertising Awards (Addy’s). The American Advertising Federation of Hampton Roads. 

(Virginia Beach, VA): Juried, Local (2 x Silver medal)
▸ 2022 The Richmond Show. (Richmond, Virginia): Juried, Regional (3 accepted entries)
▸ 2021 National Student Show competition: Juried, National (Accepted entry)



▸ 2021 Innovation Center for Design Excellence (ICDE) design competition: Juried, National (Silver medal)
▸ 2021 American Advertising Awards (Addy’s). The American Advertising Federation of Hampton Roads. 

(Virginia Beach, VA): Juried, Local (Silver medal)
▸ 2021 MSU GLITCH Competition (Starkville, Mississippi): Juried, National 
▸ 2020 AIGA Blue Ridge’s Annual Flux Student Design Competition (Frederick, MD): Juried, National (All 

semi-finalists: Kayla Everett, Bathany Holdcroft)
▸ 2020 The Richmond Show. (Richmond, Virginia): Juried, Regional (Ian Cox [Bronze])
▸ 2019 Communication ArtS Design Annual; Juried international. (Max Tran, Arts371.) One of only twelve 

pieces accepted internationally for publication
▸ 2019 American Advertising Awards (Addy’s). The American Advertising Federation of Hampton Roads. 

(Virginia Beach, VA): Juried, Local (Jasmine Gasca [gold medal])
▸  2019 AIGA Blue Ridge’s Annual Flux Student Design Competition (Frederick, MD): Juried, National
▸ 2019 MSU GLITCH Competition (Starkville, Mississippi): Juried, National
▸ 2019 CMYK Magazine. CMYK’s Top 100 New Creatives 58. Juried. National.
▸ 2018 Adobe Design Acheivement Awards: Juried, Interational (All semi-finalists: Cherlyn Rebultan, ArtS 371 

and 395 [3x], Breanna Parker, ArtS 371 and 395 [2x])
▸ 2018 American Advertising Federation National Addys: Juried, National (Cherlyn Rebultan [silver medal])
▸ 2018 National Student Show competition: Juried, National (Cherlyn Rebultan, ArtS372, [Accepted entry]; 

Holli Turner, ArtS 395, [Accepted entry])
▸ 2018 American Advertising Federation District 3 Addys: Juried, Regional (Holli Turner [silver]; Cherlyn 

Rebultan [silver])
▸ 2018 GLITCH National Student Design Competition (Ronald Delk, ArtS371)
▸ 2018 AIGA Blue Ridge’s Annual Flux Student Design Competition (Frederick, MD): Juried, National (All 

semi-finalists: Sean Matias, ArtS 395/ David Truong, [x2]/ Brandon Harrell, [x2]ArtS 371/ Brianna Ivey, ArtS 
395/ Holli Turner, [x3]/ Ronald Delk, ArtS 371/ Matt Meres, [x2]/ Cherlyn Rebultan, [x4])

▸ 2018 Communication ArtS Illustration Annual Short list (unpublished) (Holli Turner, Arts395. International. 
One of the 20% of 1750 entries selected)

▸ 2018 Hampton Roads American Advertising Federation (Holli Turner, Arts395; Cherlyn Rebultan ArtS 371)
▸ 2018 Richmond Show: Juried, Regional (Anna Kiriakou, ArtS 371 [silver medal]; Mandy Vollmer, Arts395 

[silver medal])
▸ 2017 Adobe Design Acheivement Awards: Juried, Interational (All semi-finalists: Cherlyn Rebultan [4x], Holli 

Turner [3x], Mandi Vollmer [2x], Christine Vreeland, Julia Drake, Joshua Strasshofer, Alex Salas [3x], Rosson 
Allen, Galina Karasoy [3x])

▸ 2017 American Advertising Federation District 3 Addys: Juried, Regional (Holli Turner [silver])
▸ 2017 AIGA Blue Ridge’s Annual Flux Student Design Competition (Frederick, MD): Juried, National (Julia 

Drake,ArtS371 honors project / Rachael Round, ArtS395 / Galina Karasoy ArtS395 / Rosson Allen, [2x]Arts395 
/ Colleen Davenport, ArtS 395)

▸ 2016 Adobe Design Acheivement Awards: Juried, International (All semi-finalists: Galina Karasoy, ArtS371 / 
Rachael Round ArtS 395)

▸ 2016 American Advertising Federation District 3 Addys: Juried, Regional (Michael Watts, Arts395 [gold] / 
Galina Karasoy, ArtS371 [silver])

▸ 2016 National Student Show competition: Juried, National (Selected entries: Colin Grey, Arts395 / Jessica 
Young Arts395

▸ 2016 AIGA Blue Ridge’s Annual Flux Student Design Competition (Frederick, MD): Juried, National 
(Selected entries: Julia Drake,ArtS371 / Joshua Strasshofer, ArtS370 / Jessica Young, ARTS395 )

▸ 2015 American Advertising Federation District 3 Addys: Juried, regional (Sandra Connors, Silver medal)
▸ 2015 Hampton Roads American Advertising Federation: Juried, regional (Sandra Connors, Gold medal)
▸ 2015 Hampton Roads American Advertising Federation. Juried, regional (Silver medal, Casey Rowan)
▸ 2014 Communication ArtS Typography Annual; Juried international. (Robert Wolford, Arts475.) One of only 

twenty pieces accepted for publication
▸ 2014 Hampton Roads American Advertising Federation (Regional. Silver medal, Alejandro Betancor)

Texas State University–San Marcos (selected)

International
▸ Graphis magazine



▸ Graphis magazine international student competition
▸ Graphis Logo Design 4 Annual, an international design annual
▸ How magazine international design annual
▸ Type Directors Club of New York Annual

National
▸ CMYK magazine national student competition
▸ Adobe Flashpoint national student competition
▸ Step by Step magazine national design annual
▸ The Creative Summit student competition

Regional and Local
▸ The Austin Advertising Federation student competition
▸ The Art Directors Club of Houston student competition
▸ The Dallas Society of Visual Communications student competition
▸ The San Antonio Advertising Federation Addys student competition

SCHOLARLY/CREATIVE

* All collaborative projects have been noted at the end of the entry along with an indication of my role.

CREATIVE BOOKS
▸ 2004 Shopworn, White Gas Design, photography, and production.
▸ 2003 Possum Box, White Gas Design, photography, writing, and production with Mark Todd.
▸ 2001 Ashe Motors, Depraver Press. Design, photography, writing, and production with Mark Todd.
▸ 1999 Catfish Hens, Depraver Press. Design, photography, and production with Mark Todd.
▸ 1997 Badlands, Depraver Press. Design with William Meek, and Mark Todd.

PROFESSIONAL DESIGN WORK

Old Dominion University

2022
▸ Lake Ouachita Vista Trail Committee, USFS, and Arkansas Parks and Tourism: Design of didactic signage 

program for the final four stages of the trail. Commission, work in progress.

2021
▸ Lake Ouachita Vista Trail Committee, USFS, and Arkansas Parks and Tourism: Design of didactic signage 

program for the final four stages of the trail. Work in progress. Production delayed by COVID and associated 
materials shortages.

2020
▸ Gerhard Steidl GmbH & Company (Göttingen, Germany ) and Mark Peterson: Design for the book, White 

Noise, Photographs by Mark Peterson. Designer, typographer with Mark Peterson. Commission completed in 
late 2020, release delayed due to COVID.

▸ Lake Ouachita Vista Trail Committee, USFS, and Arkansas Parks and Tourism: Design of didactic signage 
program for the final four stages of the trail. Work in progress with production to resume later in 2021.

2019
▸ Bloodshot records and Scott Biram (Chicago, IL): Design and production oversight for packaging of the audio 

compact disc, Sold out to the devil, Gospel cuts. Designer, with Mark Todd.
▸ Bloodshot records and Scott Biram (Chicago, IL): Design and production oversight for packaging of the audio 

compact disc, Fever Dreams. Designer, with Mark Todd. 
▸ Bloodshot records and Scott Biram (Chicago, IL): Design and production oversight for screen printed poster, 

Rev. Biram Saves! Designer
▸ North Shore Point House Concerts. (Norfolk, VA): Design and printing of letterpress poster series for a series 

of three posters promoting concerts staged at Th e Goode Theatre, Old Dominion University. Designer, with 
Ivanete Blanco through R-N-R Showprint.

2017



▸ Bloodshot records and Scott Biram (Chicago, IL): Design and production oversight for The Bad Testament tour 
promotional merchandise. Designer, with Mark Todd.

▸ Monarch Magazine, Karen Smallets and Philip Walzer (Norfolk, VA): Cover Design, letterpress printing, and 
digital production. Designer with Ivanete Blanco, through R-N-R Showprint.

▸ Cantabile Project: Karen Hoy (Norfolk, VA):  
Design of marketing materials (poster and program) for the recital “Liebe”.  
Designer with Ivanete Blanco.

2016
▸ Gerhard Steidl GmbH & Company (Göttingen, Germany ) and Mark Peterson: Cover and typographic design 

for the book, Political Theatre, Photographs by Mark Peterson. Designer, typographer with Mark Peterson.
▸ Universal Music Group (London Division), and Frankie and Annette Miller: Design and production oversight 

for the packaging of the digital video disc, Frankie Miller’s Double Take. Designer, with Mark Todd, and 
production consultant.

▸ Universal Music Group (London Division), and Frankie and Annette Miller: Design and production oversight 
for the packaging of the audio compact disc, Frankie Miller’s Double Take. Designer, with Mark Todd, and 
production consultant.

▸ Universal Music Group (London Division), and Frankie and Annette Miller: Design and production oversight 
for the packaging of the vinyl longplay (LP), Frankie Miller’s Double Take. Designer, with Mark Todd, and 
production consultant.

▸ Bloodshot records and Scott Biram (Chicago, IL): Design and production oversight for the packaging of the 
audio compact disc, The Bad Testament. Designer, with Mark Todd.

▸ Bloodshot records and Scott Biram (Chicago, IL): Design and production oversight for the packaging of the 
vinyl longplay, The Bad Testament. Designer, with Mark Todd, and production consultant.

▸ Brian Nedvin (Norfolk, VA): Design of the promotional poster for the staging of the opera, The Medium: 
Designer, through R-N-R Showprint.

▸ Cantabile Project (Norfolk, VA): Design of the promotional poster for the performance, War and Peace. 
Designer, through R-N-R Showprint.

▸ Prewitt Custom Creations (Oklahoma City, OK): Identity design. Designer, through R-N-R Showprint.
▸ Imtiaz Habib (Norfolk, VA): Design of the promotional materials for Shakespeare 400 years after: A public 

Event. Designer, through R-N-R Showprint.

2015
▸ AIGA Design Educators Community: Design and printing of letterpress certificate of appreciation.  

Designer and printer ,through R-N-R Showprint.
▸ Cantabile Project: Karen Hoy (Norfolk, VA): Design of marketing materials for the performance “Mahler 

Liederabend”. Designer, through R-N-R Showprint.
▸ Team 911 Warriors: Marc Cunningham (Hampton Roads): Design logo concept for the Team 911 Warriors 

organization, which is a support network for veterans.  
Designer, through R-N-R Showprint.

▸ Lynn Pearce (Dallas, TX): Design of a logo and business card for her company Lynn’s Classic Photography. 
Designer, through R-N-R Showprint.

▸ Agnieszka Whelan (Norfolk, VA): Design of poster for the lecture Design is of Things Not Yet Appearing: 
Gardens and Landscapes on Paper by John Dixon Hunt.  
Designer, through R-N-R Showprint.

2014
▸ Louisiana Tech University freshman enrichment program. (Ruston, LA): Design of the logo for the Blue Fire 

freshman retention program. 
Designer, with Professor Jonathan Donehoo

▸ Brian Nedvin, (Norfolk, VA): Design of poster and program from a production  
of the opera Cosi Fan Tutte. 
Designer ,through R-N-R Showprint

▸ Cantabile Project: Karen Hoy (Norfolk, VA):  
Design of marketing materials (poster and program) for the performance “Where does the music come from? 
What motivates us to sing?” 



Designer ,through R-N-R Showprint
▸ Old Dominion University: Art Department (Norfolk, VA): Design of letterpress poster promoting the Spring 

Break trip to Washington, D.C.  
Designer and printer with Ivanete Blanco

▸ The Wells Theatre: Ashley Pirsig (Norfolk, VA): Marketing Materials  
Design of marketing materials (logo, save the date, poster, advertisements, invite, etc) for the Centennial Gala 
celebrating the 100th anniversary of the Wells Theatre.  
Designer with Ivanete Blanco

2013 
▸ Cantabile Project: Karen Hoy (Norfolk, VA):  

Design of marketing materials (poster and program) for the recital “Measure of Our Years”.  
Designer with Ivanete Blanco

▸ Old Dominion University: Art Department (Norfolk, VA):  
Design of letterpress poster promoting the Richmond First Friday Field Trip. 
Designer and printer with Ivanete Blanco 

▸ Jacqueline Grubb (Chesapeake, VA):  
Design of logo and stationery system to be used for a non-profit program called H.O.R.S.E.S. Inc., a horse back 
riding program to counsel at-risk kids, at Grubb Grove Horse Farm.  
Designer with Ivanete Blanco

▸ Old Dominion University: Art Department (Norfolk, VA):  
Design of letterpress poster promoting the workshop and presentation by visiting artist Jim Sherraden from 
Hatch Show Print.  
Designer and printer with Ivanete Blanco

▸ Old Dominion University: Art Department (Norfolk, VA):  
Design of letterpress poster promoting the Spring Break trip to New York City.  
Designer and printer with Ivanete Blanco

▸ Brian Nedvin and Topher Jones (Norfolk, VA):  
Design of poster promoting the production of A Taste of Mozart. 
Designer with Ivanete Blanco

▸ Casa De Don Lorenzo (San Marcos, TX): 
Design of identity and signage

Texas State University–San Marcos

2011
▸ Lake Ouachita Vista Trail Committee, USFS, and Arkansas Parks and Tourism 

Design of trailhead kiosk and entry signage for ADA accessible Watchable Wildlife Trail.
▸ Lake Ouachita Vista Trail Committee, USFS, and Arkansas Parks and Tourism  

Design of trail didactics for ADA accessible Watchable Wildlife Trail.
▸ Friends of Lake Ouachita 

Design of identity, paper system (letterhead, purchase order, tracking and maintenance forms), and uniforms 
for park docents.

▸ Bloodshot Records, Packaging for audio CD, LP, and vinyl singles for Bad Ingredients, by Scott Biram. Design 
consultant with Mark Todd.

2010
▸ Lake Ouachita Vista Trail Committee, USFS, and Arkansas Parks and Tourism 

Design of Section 3, trailhead kiosk.
▸ Lake Ouachita Vista Trail Committee, USFS, and Arkansas Parks and Tourism 

Design of collateral materials for sale in area resort retail stores.
▸ Leatherbag, Design of packaging for audio CD, HeyDay. Designer with Mark Todd.

2009
▸ Ivyworldwide, Headquarters: Austin, TX 

Design consultant for Ivyworldwide web site for social media marketing firm. Commission through Olive Design.
▸ Wind Coalition 

Design consultant for web site of a non-profit association promoting the development of wind energy in Texas 
and surrounding states. Commission through Olive Design.



▸ Lake Ouachita Vista Trail Committee, USFS, and Arkansas Parks and Tourism 
Redesign of trail identity system.

▸ Lake Ouachita Vista Trail Committee, USFS, and Arkansas Parks and Tourism 
Design of trail wayfinding system and trailhead kiosks for the second stage of the trail.

▸ Lake Ouachita Vista Trail Committee, USFS, and Arkansas Parks and Tourism 
Kiosk and wayfinding system for wetlands walk.

▸ Urban Mud, Jacksonville, FL 
Design of identity system, paper system, uniforms and stamping dies for a custom  
concrete fabricator.

2008
▸ Lake Ouachita Vista Trail Committee, USFS, and Arkansas Parks and Tourism 

Design of promotional materials for the Vista Trail Marathon.
▸ Lake Ouachita Vista Trail Committee, USFS, and Arkansas Parks and Tourism 

Design of Graphic Identity for Vista Trail merchandise.
▸ Lake Ouachita Vista Trail Committee, USFS, and Arkansas Parks and Tourism 

Design of Traildogs group support materials and blog.
▸ Professor Beverley Penn 

Design of University of Texas, El Paso ceremonial mace proposal book.  
Designer with Christopher Sipes, illustrator.

▸ Texas State University-San Marcos Department of English, the Lindsey Literary Series, the Katherine Anne 
Porter Literary Center, the Wittliff Collections 
Design of poster and materials for a lecture by writer James Young.

2007
▸ Lake Ouachita Vista Trail Committee, USFS, and Arkansas Parks and Tourism 

Design of collateral materials, maps, and signage for the opening of the second stage of the trail.
▸ Lake Ouachita Vista Trail Committee, USFS, and Arkansas Parks and Tourism 

Design of promotional materials for the Second Annual Lake Ouachita clean-up.
▸ Lake Ouachita Vista Trail Committee, USFS, and Arkansas Parks and Tourism 

Design of identity for the Traildogs group.
▸ Resilience Corporation, Ndurant group with Tree House studios, Nashville, TN 

Typographic design consultant for the Reformat of sales sheet system.
▸ University of Texas Press 

Design of advertising series promoting 2007 new releases in national literary journals and trade publications. 
Designer with Professor Mark Todd.

2006
•Vista Trail Committee, USFS, and Arkansas Parks and Tourism 

Design of collateral materials and maps for the first stage of the trail.
▸ Blue Dog Jewelry Design, San Marcos, TX 

Design and photography for identity and packaging design.
▸ LuLu Jewelry Design, Wimberley, TX 

Design of identity and packaging design.

2005
▸ Vista Trail Committee, USFS, and Arkansas Parks and Tourism 

Design of Collateral materials, maps, signage and identity for the Lake Ouachita Vista Trail.
▸ Habitat for Humanity, Wimberley, TX 

Design of collateral materials and promotions for 2005 fundraising.
▸ Blue Dog Jewelry Design, San Marcos, TX 

Design of identity and packaging design.
▸ LuLu Jewelry Design, Wimberley, TX 

Design of identity and packaging design.

2002
▸ Mt. Ida, Arkansas Chamber of Commerce 



Design of paper system.
▸ Mt. Ida, Arkansas Chamber of Commerce 

Design of outdoor board.
▸ Songbird Gardens, Mt. Ida, AR 

Design of print advertisements.
▸ Songbird Gardens, Mt. Ida, AR 

Design of point of purchase materials.

2001
▸ Loudhouse Records, Austin, TX 

Design and photography for packaging of the audio compact disc Conway’s Corner by R.C. Banks. Designer with 
Mark Todd.

▸ Loudhouse Records, Austin, TX 
Design of identity design.

▸ Songbird Gardens 
Design and photography for print advertisements.

▸ Songbird Gardens 
Design and photography for point of purchase materials.

2000
▸ MonsterDaata.com 

Design of corporate identity. Commission through Olive Design.
▸ Question.com 

Design of corporate identity. Commission through Olive Design.
▸ Mt. Ida, Arkansas Chamber of commerce 

Design of identity.
▸ Mt. Ida, Arkansas Chamber of commerce.  

Design of promotional materials.
▸ Mt. Ida, Arkansas Chamber of commerce.  

Design of signage and outdoor boards.
▸ Songbird Gardens. Design of stock certificates.

1999
▸ Office Domain 

Design of corporate identity. Commission through Design House, Austin, TX.
▸ Rx.com 

Cover designs for a publication promoting on-line services. Commission through Design House.
▸ Derek Besant 

Design of a catalogue for The Sleepless Night, an internationally touring exhibition of the  
artist’s work. Designer with Mark Todd.

▸ Austin Museum of Art, Austin, Texas 
Photography, design and production of the invitation for the exhibition, Oil Patch Dreams Photographer and 
designer, with White Gas.

▸ Wichita, Kansas Museum of Art 
Design and photography for the invitation to the exhibition, Oil Patch Dreams. Photographer and designer with 
White Gas.

▸ Louisiana Tech University, Ruston LA 
Design of a poster for the Tech Rome Program. Designer with Professor Jonathan Donehoo.

1998
▸ Works.com 

Design and development of corporate identity for software company. Commission through Design House.
▸ The Art Museum of Southeast Texas, Beaumont, TX 

Photography, design and production of the didactics for the exhibition Oil Patch Dreams. Photographer and 
designer, with White Gas.

▸ The Art Museum of Southeast Texas, Beaumont, TX 



Photography, design and production of poster for the exhibition Oil Patch Dreams.  
Photographer and designer, with White Gas.

▸ Sony / Lucky Dog Records 
Photography for repackaging of the audio compact disc Wrapped by Bruce Robison. Photographer with Professor 
Mark Todd.

▸ Sony / Lucky Dog Records 
Photography for national promotional campaign for audio compact disc Wrapped by Bruce Robison. 
Photographer with Professor Mark Todd.

▸ Pervasive Software, Inc 
Design and production of the packaging for software company. Designer and production artist with Assistant 
Professor Holly Sterling.

1997
▸ Trilogy Software International 

Design of Web site homepage. Art Director with Assistant Professor Holly Sterling.
▸ IBM 

Web browser interface development and design. Art Director with Assistant Professor Holly Sterling.
▸ Boar’s Nest Records, Austin, TX 

Design of corporate identity.
▸ Boar’s Nest Records, Austin, TX 

Photography and design of the packaging for audio compact, Wrapped, by Bruce Robison. Designer and 
photographer with White Gas.

1996
▸ Texas State University, Department of Art and Design 

Design and production of publication, The Article, Issue VI.
▸ Louisiana Tech University 

Design of a poster for the Tech Rome Program. Designer, with Professor Jonathan Donehoo
▸ Texas State University, Department of Art and Design 

Design and production of the publication, The Article, Issue V.
▸ Kathryn Riley, Baton Rouge, LA 

Design of point of purchase materials and identity development.
▸ Professor John Belisle, Austin, TX 

Design and production of a promotional brochure.
▸ Cara Blackwell, Austin, TX 

Design of corporate identity for print production specialist.

1995
▸ Texas State University, Department of Art and Design 

Design and production of the publication, The Article, Issue IV.

1994
▸ Texas State University, Department of Art and Design 

Design and production of the publication, The Article, Issue III.

1993
▸ Willingway Hospital, Savannah, GA 

Design of the Alumni Association identity.
▸ Willingway Hospital Outpatient Affiliate, Savannah, GA 

Art direction and production of B/W print advertisement series.
▸ United Way, Savannah, GA 

Design of the Day of Caring Identity.
▸ Sicola Martin, Austin, TX 

Design and illustration for the Paddlefest identity and T-shirt.
▸ Motorola PowerPC 

Design of direct mail campaign. Commission through Sicola-Martin Advertising, Austin, TX.
▸ Texas State University, Department of Art and Design 

Design and production of the publication, The Article, Issue III.



1992
▸ Willingway Hospital, Savannah, GA 

Design of the Patient Handbook.
▸ Willingway Hospital, Savannah, GA 

Design of the collateral materials and identity.
▸ Willingway Hospital, Savannah, GA 

Art direction and illustration of print campaign.
▸ Texas State University, Department of Art and Design 

Design and production of the publication, The Article, Issue II.
▸ Texas State University, Department of Art and Design 

Design and production of the publication, The Article, Issue I.

UNCOMMISSIONED DESIGN AND RESEARCH PROJECTS

Old Dominion University

2017‑Present 
▸ The FYT Project. Completed design and production of a series of prints created as responses to the growing 

resistance movement triggered by the 2016 U.S. elections. Designer and printer, through R-N-R Showprint.
▸ ODU Letterpress collection cataloging project. 

2016–Present
▸ RNR Dry-bys Letterpress Project. Designer and printer, through R-N-R Showprint in collaboration with 

Ivanete Blanco, Norfolk designers and printers Stacey Crenshaw (Prince, Inc) and Rob Crenshaw (Hanbury 
Architecture), San Antonio, TX designer Rolando Murillo (Murillo Design/HEB), Austin, Tx Designer and 
creative lead, Craig Crutchfield (McGarrah-Jessee).

2015–Present
▸ The Smithville Papers Letterpress Project. Completed the design and production of the first 15 prints of 

the series which will eventually consist of eighty-four prints, each corresponding to one of the eighty-four 
selections contained on Harry Smith’s storied Anthology of American Folk Music, which will eventually be 
compiled in a book.  
Designer and printer, through R-N-R Showprint.

2014
▸ R-N-R Showprint. (Norfolk, VA) Identity and business cards.  

Designer and printer, through R-N-R Showprint
▸ R-N-R Showprint. (Norfolk, VA) Website, designed and produced website to  

promote R-N-R showprint.  
Designer, through R-N-R Showprint

2008
▸ Brownsear.com 

Interface design.

2007
▸ Brownsarm.com. 

Designer, photographer.

CONSULTANCIES

Old Dominion University

2017
▸ Lake Ouachita Vista Trail Committee, USFS, and Arkansas Parks and Tourism. Design proposal and 

production projection/bidding for grant proposal to implement didactic program for the final four sections of 
the trail completed in 2015. Grant approved, 2017.

▸ Liz Zanoni, Assistant professor, Department of History, ODU. Digital image preproduction for publication.

2014
▸ Lake Ouachita Vista Trail Committee, USFS, and Arkansas Parks and Tourism. Graphic development for 

impending renaming and rebranding of the Lake Ouachita Vista Trail to the LOViT Trail in conjunction with 
the completion and designation of the trail as an IMBA Epic Trail.  



Design and marketing strategy consultant
▸ Treehouse Studios (Nashvile, TN). Development of Software purchasing and strategies. Consultant.
▸ College of the Albermarle. Gale Flax, Chair. Elizabeth City, NC. Developed a proposed course curriculum for 

the Fine ArtS Department’s ART 171 Computer Art 1 course. In a 5 hour session, we consulted with the faculty 
and chair, and presented course materials and resources pertinent to the course. Developer and presenter, with 
Ivanete Blanco.

Texas State University–San Marcos

2011
▸ Novo Nordisk, Glaxo Smith Kline and Amgen via Prime-Medica  

Development of design system for web based pharmaceutical marketing tool.  
Design consultant through Olive Design.

2010
▸ Profitfuel 

Development of website design. Design consultant through Olive Design.
▸ Motive, an Alcatel-Lucent Company 

Development of website design. Design consultant through Olive Design.
▸ Resilience Corporation, Ndurant group 

Development of typographic system for SCS data sheet conversion. Design consultant through Tree House studios, 
Nashville, TN.

2009
▸ Resilience Corporation, Ndurant group 

Development of design structure for digital migration of hardware sales sheet program.  
Design consultant through Tree House studios, Nashville, TN

2008
▸ Resilience Corporation, Ndurant group 

Development of design structure and typographic system for router sales sheet program.  
Design consultant through Tree House studios, Nashville, TN.

▸ Chaos Group Austin, TX 
Development of typographic system and structure for book design.

1992–1998
▸ SicolaMartin Advertising, Austin, TX 

Provided technology consultation and trained new art directors during this period.

1998–2000
▸ Design House, Austin, TX 

Provided technology support and consultation during this period.

PUBLISHED PHOTOS AND REVIEWS OF CREATIVE WORKS

Texas A&M University–Corpus Christi

2023
▸  The Society of Typographic Arts. 2022 STA 100. Web (https://100.sta-chicago.org/winners/by-year/2022) and 

(https://100.sta-chicago.org/winners/2022/the-smithville-papers-number-14) 
Piece Exhibited: The Smithville Papers: Number 14

 2022
▸  10th Annual International Juried Print Exhibition. Remarque/New Grounds Print Workshop & Gallery, 

Albuquerque, New Mexico. Web (https://www.remarqueprintshop.com/10th-international-juried-print-
exhibition.html) 
Piece Exhibited: The Smithville Papers: Number 11

▸  3rd Annual International FPG Print Exhibition. Fresno Printmakers’ Guild, Fresno, CA. Web (https://
fresnoprintguild.com/up-coming-events/2022-exhibitions/3rd-annual-juried-fpg-print-exhibition/) 
Piece Exhibited: The Smithville Papers: Number 13, The Smithville Papers: Number 14, and Your Vote Matters

Old Dominion University



2022
▸ 2022 New Impressions 2022: An International Exhibition of Letterpress Printing. Hamilton Wood Type 

& Printing Museum, Two Rivers, WI. Catalog (https://indd.adobe.com/view/728cee01-040e-4678-af4c-
0cd191b2a415) and Web (https://artspaces.kunstmatrix.com/en/exhibition/9838663/new-impressions-2022 
Your Vote Matters Poster

2021
▸  2021 The Society of Typographic Arts. 2021 STA 100. Web (https://100.sta-chicago.org/winners/2021/your-

vote-matters) 
Your Vote Matters Poster

▸  2021 WHATEVS. Art Fluent, Online Exhibitions. Web (https://www.art-fluent.com/whatevs) 
Climate Change in a HOAX

2020
▸ 2020 New Impressions 2020: An International Exhibition of Letterpress Printing. Hamilton Wood 

Type & Printing Museum, Two Rivers, WI. Catalog (https://issuu.com/hamiltonwoodtype/docs/
newimpressions2020catalogissuu) and Web (https://artspaces.kunstmatrix.com/en/exhibition/1805674/new-
impressions-2020) 
Americana Fest Poster

▸  Creativity 49. Creativity Print & Packaging International Awards. Design Annual (in-print) Mobile App and 
Web (in-progress) 
John Paul White Letterpress Poster

2019
▸ 2019 Graphic Design USA. American Graphic Design Awards. Kay Publishing Corporation. Print
(December, p. 174), Web (http://contests.gdusa.com/gdusa-contest-winner?cc=agda19&ids
=0|1417&iy=&im=) and Mobile App
Americana Fest Letterpress Poster
▸ The Society of Typographic Arts. 2019 STA 100. Web (https://100.sta-chicago.org/
winners/2019/no-wall-no-ban)
No Wall No Ban Letterpress Poster
▸ New Impressions 2019: An International Exhibition of Letterpress Printing. Hamilton Wood
Type & Printing Museum, Two Rivers, WI. Catalog (https://issuu.com/hamiltonwoodtype/
docs/newimpressions2019exhibitioncatalog)

2018
▸ Creativity 48. Creativity International Awards Annual. Mobile App and Web (https://creativityawards.

com/?submission=liebe-love-songs-of-robert-schumann-jake-heggie) 
Featured piece:  LIEBE Poster

2017
▸ Designobserver.com: AIGA, 50 Books/50 Covers.  

Website <designobserver.com/50Books50Covers-2016.php?type=covers > 
Featured piece: Cover design for the book, Political Theatre, Photographs by Mark Peterson. Gerhard Steidl 
GmbH & Company (Göttingen, Germany )

▸ Designarchives.aiga.org: AIGA, 50 Books/50 Covers. 
Website: < http://designarchives.aiga.org/#/entries/%2Bcollections%3A%2250%20Books%20%7C%2050%20
Covers%20of%202016%22/_/detail/relevance/asc/87/7/21889/political-theatre/1> 
Featured piece: Design for the book, Political Theatre, Photographs by Mark Peterson. Gerhard Steidl GmbH & 
Company (Göttingen, Germany )

▸ Graphic Design USA. American Graphic Design Awards. Kay Publishing Corporation. Print (December, p. 
160), Web (http://contests.gdusa.com/gdusa-contest-winner?cc=agda17&ids

=0%7C1603207&iy&im) and Mobile App 
Featured piece: War & Peace Poster

▸ Creativity 47. Creativity International Awards Annual. Mobile App and Web (http://creativityawards.
com/?submission=war-peace-poster) 
Featured piece: War & Peace Poster

2016



▸ Communication ArtS Magazine: Typography Annual 6. Print (January/February Issue; p. 89) and Web (http://
www.commarts.com/gallery/typography/posters/all/2016) 
Featured piece: Cosi Fan Tutte Poster

▸ Creativity 45. Creativity International Awards Annual. Mobile App and Web (http://creativityawards.
com/?submission=cosi-fan-tutte-poster)  
Featured piece: Cosi Fan Tutte Poster 

▸  Graphic Design USA. American Graphic Design Awards. Kay Publishing Corporation. Print (December, p. 
171), Web (http://contests.gdusa.com/competitions/graphic-design/2016-22 : IVANETE BLANCO american-
graphic-design-awards-winner?eid=1601305) and Mobile App 
» 400 Years After Shakespeare Poster

2015 
▸ Print Magazine. Print Regional Design Annual. Print (Winter Issue; p. 84) and Web (Pending)Featured piece: 

Cosi Fan Tutte Poster
▸ Graphic Design USA. American Graphic Design Awards. Kay Publishing Corporation. Print (November/

December, p. 182), Web (http://contests.gdusa.com/uncategorized/2015-american-graphic-design-awards-
winner?eid=8146) and Mobile App 
Featured piece: Cosi Fan Tutte Poster

▸ Creativity 44. Creativity International Awards Annual. Mobile App and Web (http://creativityawards.
com/?submission=first-friday-letterpress-poster)  
Featured piece: First Friday Letterpress Poster 

2014
Spring 2014
▸ Graphic Design, USA. American InHouse Design Awards (May):  

Featured piece: Hatch Showprint Workshop/Lecture Poster. 
Print (July/August, p. 141), Web (http://gdusa.com/contests/aida14/winners/gallery.php?c=14) and Mobile 
App 
Designer and printer, through R-N-R Showprint

▸ Communication ArtS Magazine: Typography Annual 4. Juried Competition, International  
Featured piece: Hatch Showprint Workshop/Lecture Poster. 
(January/February Issue; p. 93) and Web (http://www.commarts.com/SearchOn.
aspx?colpg=0&col=1198&inum=396) 
Designer and printer, through R-N-R Showprint 

2013
▸ Creativity 43. Creativity Print & Packaging International Awards (September):  

Juried Competition, International web site featured: 
Hatch Showprint Lecture Poster 
Philadelphia Field Trip Poster  
Enjoy: Holiday Card 
(http://www.creativityawards.com/index.php?pr=43A_Poster) and (http://www.creativityawards.com/
index.php?pr=43A_Cards_and_Invitations)  
Designer and printer, through R-N-R Showprint

▸ CMYK Magazine Volume 55. Professional Showcase Volume 4: Juried Competition, National Print (p. 16) 
Featured piece: First Friday (Richmond Trip) Poster 
Designer and printer, through R-N-R Showprint

Texas State University–San Marcos

2006
▸ Work from Ashe Motors and Possum Box featured in the book Handmade, by Andrea Lugli, Gingko Press, 

Spring 2006.

2004
▸ Print Regional Design Annual 2004, a national design annual, featured selections from  

the book Possum Box.

2003
▸ How International Design Annual 2003, an international design annual, featured selections  



from the book Ashe Motors.

2002
▸ Communication ArtS 2002 Design Annual, an international design annual, featured selections from the book 

Ashe Motors.
▸ Print Regional Design Annual 2002, a national design annual, featured selections from the  

book Ashe Motors.
▸ Powerful Page Design: Top Designers Lay Out Their Concepts To Reveal Their Inspirations,  

HOW Design Books, featured selections from the book Catfish Hens.

2000
▸ Typography 21, the annual of the Type Directors Club of New York, featured selections from the book Catfish 

Hens.
▸ Print Regional Design Annual 2000, a national design annual, featured selections from the book Catfish Hens.
▸ 2000 Books, Nexus Press, Atlanta Contemporary Art Center, Atlanta, Georgia featured selections from the 

book Catfish Hens.

1994
▸ Print Regional Design Annual 1994, a national design annual, featured selections from the Creative Summit 

Poster series. Designer with Hill Group.
▸ Print Regional Poster Annual 1994, a national design annual, featured selections from the Creative Summit 

Poster series. Designer with Hill Group.

AWARDS AND HONORS

Texas A&M University–Corpus Christi

2022
▸   Typographic Award of Excellence, 
The Society of Typographic Arts. 2022 STA 100. (December) Juried Competition, International (Judges: Rick 

Griffith, Ben Blount, Yeohyun Ahn, Rafaela Dražic)
Selected entry: The Smithville Papers: Number 14 

Old Dominion University

2021
▸   Award of Excellence, The Society of Typographic Arts. 2021 STA 100. (December) Juried Competition, 

International (Judges: David Pearson, Mathieu Lommen, Patric King, Jill Shimabukuro)
  Selected entry: Your Vote Matters Letterpress Poster

2019 
▸   Gold Award, Creativity 49. Creativity Print & Packaging International Awards. (September) Juried 

Competition, International
  Selected entry: John Paul White Letterpress Poster
▸   Award of Excellence, The Society of Typographic Arts. 2019 STA 100. (October) Juried Competition, 

International 
(Judges: Ellen Lupton, Matthew Hoffman, Meriah Garrett, and Aarron Walter)

  Selected entry: No Wall No Ban Letterpress Poster
▸   Award of Excellence, Graphic Design USA. American Graphic Design Awards. (October) Juried 

Competition, National (Judges for this competition was not disclosed.)
 Award of Excellence: Americana Fest Letterpress Poster

2018
▸ (short list, unpublished) Communication ArtS Magazine: Typography Annual 8. 

Juried Competition, International (Judges: Chad Michael, principal [Chad Michael Studio, Dallas, TX], 
Ksenya Samarskaya, principal [Samarskaya & Partners, NY, NY], Michael Stinson, creative director and type 
editor [Ramp Creative+Design, Los Angeles, CA] 
Selected entry: Poster Design for The Medium.

▸ Silver Award, Creativity 48. Creativity Print & Packaging International Awards. (September) Juried 
Competition, International (Judges: Jason Lee, USA; Zach Stewart, USA; Frank Walters, UK; Shadi Al Hroub, 
Jordan; Mario Natarelli, USA, Kira Sea, USA; John Howells, USA; Zhou Wenjun, China; Dan Dry, USA; Erik 
Borreson, USA)  
Selected entry: LIEBE Poster



2017
▸ Winner, AIGA, 50 Books/50 Covers. 

Juried Competition, International (Judges: Gail Anderson [Anderson Newton Design, NY,NY], Michael 
Carabetta [Chronicle Books, San Francisco, CA], Jessica Helfand [Design Observor])Selected entry: Design 
for the book, Political Theatre, Photographs by Mark Peterson. Gerhard Steidl GmbH & Company (Göttingen, 
Germany ) Selected from 700 entries.

▸ Bronze Award, Creativity 47. Creativity Print & Packaging International Awards (September). 
Juried Competition, International (Judges: (Judges: David Vawter, [Doe-Anderson, USA]; Simon Dawson, 
Australia; Charlie Van Vechten, [Buchanan Brand + Design, USA]; ZHOU Wenjun, [524 Studio, China]; 
Peter Von Klueger, [Von Klueger Creative Studio inc., USA]; Elana Rudick, [Design Is Yummy, Canada]; Nisa 
Mujjalintrakool, [Dentsu Thailand]; Robert Mitchell, [Driving Growth,UAE]; Candace Jaworski, [Rockit 
Solutions, USA]; Michael Mrakovcic, [DNA Communications Group, Australia]; Ryn Bruce, [Coloryn Studio, 
USA]; Rodrigo Cordova, [FactorTres, Mexico]; Pancho Gonzalez, [Inbrax, Chile]; Clark Most, [RedPoint 
Design Direction, USA]; Les Kollegian, [Jacob Tyler, USA]; Alicia Lichens, [gelcomm, USA]; Laura 
Suuronen, UK; Daniel da Hora, [DH,LO Creative Boutique, Brazil]; Matt Gill, [Healthy Thinking Group, 
Australia]) 
Selected entry: War & Peace Poster

▸ Award of Excellence, Graphic Design USA. American Graphic Design Awards (September): Juried 
Competition,National (Judges for this competition were not disclosed.) 
Selected entry: War & Peace Poster

2016
▸ Graphic Design USA. American Graphic Design Awards (September): Juried Competition,National (Judges 

for this competition were not disclosed.) 
» Award of Excellence: Shakespeare Festival Poster

2015
▸ Award of Excellence, Communication ArtS Magazine: Typography Annual 6.  

Juried Competition, International (Judges: Jackson Cavanaugh, typeface designer, Okay Type, Chicago, 
IL; Carolina de Bartolo, designer/author, 101 Editions, San Anselmo, CA; David Kampa, design director, 
McGarrah Jessee, Austin, TX)  
Selected entry: Cosi Fan Tutte Poster

▸ Award of Excellence, Print Magazine. Print Regional Design Annual. (September): Juried Competition, 
National (Judges: Noreen Morioka, D.J. Stout, Charles S. Anderson, Louise Fili, Stephen Doyle and Ann 
Willoughby)  
Selected Entry: Cosi Fan Tutte Poster

▸ Silver Award, Creativity 45. Creativity Print & Packaging International Awards (September). 
Juried Competition, International (Judges: Dan Dry, Power Creative, USA; John Nunziato, Little Big 
Brands, USA; Alicia Lichens, Gelcomm, USA; Erik Borreson, Marshfield Clinic Heath System, USA; ; Laura 
Suuronen, UK; Frederic Vanhorenbeke, Coast Branding & Design, Belgium; Paulo Chacon Baltodano, Por 
Qué Publicidad Creative Boutique, Costa Rica; Daniel da Hora, DH,LO Creative Boutique, Brazil; Scott 
Lindsey, Abstract Explosion, USA; Ayesha Wadhwa, vivv.tv, USA) 
Selected entry: Cosi Fan Tutte Poster 

▸ Award of Excellence, Graphic Design USA. American Graphic Design Awards (September): Juried 
Competition, National (Judges for this competition were not disclosed.) 
Selected entry: Cosi Fan Tutte Poster

▸ Honorary Merit Award: Signs of the Times. Contemporary Broadside National Juried Exhibition. NDSU 
Flakoll Gallery, Fargo, ND. (March 11–April 3): Juried, National (Juror: Stephen Frech, Oneiros Press) 
Pieces Exhibited: The Smithville Papers: Number 3, The Smithville Papers: Number 4 
The Smithville Papers: Number 3 (1 of 6 awarded recipients)

2014
▸ Award of excellence, Graphic Design, USA. American InHouse Design Awards (May):  

Juried competition, National 
(Judged by Gordon Kaye, Publisher and editor; Ilana Greenberg, Creative Director; Rachel Goldberg, 
Production Director)  



Winning entry: Hatch Showprint Lecture Poster 
Designer and printer through R-N-R Showprint

▸ Design excellence award, Communication ArtS Magazine: Typography Annual 4.  
Juried Competition, International  
Published in annual and on web site.  
<http://www.commarts.com/SearchOn.aspx?colpg=0&col=1198&inum=396> 
Judges: Roberto de Vicq de Cumptich, de Vicq design, New York, NY; Sibylle Hagmann, Kontour, Houston, 
TX; Erik Marinovich, Friends of Type, San Francisco, CA  
Winning Entry: Hatch Showprint Workshop/Lecture Poster 
Designer and printer through R-N-R Showprint

▸ Creativity 44. Creativity Print & Packaging International Awards (September): Juried Competition, 
International (Judges: Andreas Kioroglou, Matadog Design, Greece; Ben Williams, R/GA, USA; John 
Carstens, SapientNitro, USA; Jonathan Butts, Hodgson/Meyers, USA; Laura Robinson, Marcelo Lopes, 
Merchan-Design, Brazil; Markus Lindsjö, Crispin Porter + Bogusky Europe, Sweden; Michael Mrakovcic, 
Randi Wolf, Randi Wolf Design, USA; Rodrigo Cordova, Factortres, Mexico; and Ryn Bruce, Coloryn Studio, 
USA)  
» Honorable Mention: First Friday Letterpress Poster

2013
▸ Gold Award: Hatch Showprint Lecture Poster
▸ Silver Award: Philadelphia Field Trip Poster 
▸ Silver Award: Enjoy: Holiday Card
Creativity 43. Creativity Print & Packaging International Awards (September):  

Juried Competition, International  
Published on web site. 
<http://www.creativityawards.com/index.php?pr=43A_Print> 
Judges: Christine Walker, Freelancer, USA; Clark Most of RedPoint Design Direction, USA; Dan Dry of 
Power Creative, USA; Mengwen Xiang of Grey Group, USA; Pancho Gonzalez of Inbrax, Chile; Sakol 
Mongkolkasetarin, Freelance, USA; Shadi al Hroub of American University of Madaba, Jordan; Solana 
Crawford of DESIGNaboutTOWN, USA; Viktor Konvalov of Konovalov.XCLV, Ukraine; and Wallace Long 
of C2M Health, Australia  
Designer and printer, with Ivanete Blanco (R-N-R Showprint)

▸ Design excellence award CMYK Magazine Volume 55. Professional Showcase Volume 4: 
Juried Competition, National  

CMYK does not disclose its judges. 
Winning Entry: First Friday (Richmond Trip) Poster 
Designer and printer, with Ivanete Blanco (R-N-R Showprint)

Texas State University–San Marcos

2003
▸ Editorial Merit Award, How International Design Annual 2003, an international design competition, for the 

design of the book Ashe Motors.

2002
▸ Bronze Medal, Dallas Society of Visual Communication, a national design competition, for design of the book 

Ashe Motors.
▸ Silver Medal, Art Directors Club of Houston, a regional design competition, for design of the  

book Ashe Motors.

2000
▸ Excellence in Typography Award, Type Directors Club of New York, an international design competition, 

for the design of the book Catfish Hens.
▸ Gold Medal, Shreveport Advertising Federation Addy Competition, Shreveport, a regional design 

competition, for the design of the Tech Rome 1999 Promotional Poster. Designer, with Professor Jonathan 
Donehoo.

▸ Golden Jalapeño Award, Communication ArtS Society of San Antonio, San Antonio, Texas, a regional 
design competition, for the design of the book Catfish Hens.

▸ Graphic Design Excellence Award, International Bienale of Graphic Design Brno 2000, Brno, Czech 
Republic, an international design competition, for design of Catfish Hens.



1999
▸ Silver Citation, Mitchell A. Wilder Awards, a regional design competition, for the design of the catalogue for 

the exhibition Mark Todd, Badlands.
▸ Award of Excellence, Dallas Society of Visual Communication, a regional design competition, Dallas, Texas. 

For the design of the catalogue for the exhibition Oil Patch Dreams.
▸ Golden Jalapeño Award, Communication ArtS Society of San Antonio, a regional design competition, San 

Antonio, Texas. For the design of the packaging for the audio compact disc  
Bad Habits by RC Banks.

▸ Golden Jalapeño Top 50, Communication ArtS Society of San Antonio, a regional design competition, San 
Antonio, Texas. For the design of the catalogue for the exhibition Mark Todd, Badlands.

▸ Golden Jalapeño Top 50, Communication ArtS Society of San Antonio, a regional design competition, San 
Antonio, Texas. For the design of the catalogue for the exhibition  
Oil Patch Dreams.

1997
▸ Award of Excellence, Council for Advancement and Support of Education, Southwest, a regional design 

competition, for the design of the The Article.

1996
▸ Award of Excellence, Council for Advancement and Support of Education, Southwest, a regional design 

competition, for the design of the Creative Summit Poster series. Designer with Hill Group.
▸ Award of Excellence, Council for Advancement and Support of Education, Southwest, a regional design 

competition, for the design of the Creative Summit Announcement poster. Designer with Hill Group.

1995
▸ Bronze Medal, 17th Annual Broadcast Designer Association, an international design competition, New York 

City, NY, Creative Summit Creative Summit Poster Series. Designer with Hill Group.
▸ Award of Excellence, Dallas Society of Visual Communication, a regional design competition, Dallas, Texas, 

for the design of the Imagines De Devocion Poster Series.
▸ Silver Medal, San Antonio Advertising Federation Addys, district IV, a regional design competition, San 

Antonio, Texas, for the design of the Imagines De Devocion Poster Series.
▸ Award of Excellence, Dallas Society of Visual Communication, a regional design competition, Dallas, Texas, 

for the design of the Creative Summit Announcement Poster. Designer with Hill Group.
▸ Award of Excellence, Dallas Society of Visual Communication, a regional design competition, Dallas, Texas, 

for the design of the Creative Summit Poster series. Designer with Hill Group
▸ Award of Excellence, Council for Advancement and Support of Education, Southwest, a regional design 

competition, for the design of the Creative Summit Poster series. Designer with Hill Group.
▸ Award of Excellence, Council for Advancement and Support of Education, Southwest, a regional design 

competition, for the design of the Creative Summit Announcement poster. Designer with Hill Group.

1994
▸ Award of Excellence, Dallas Society of Visual Communication , a regional design competition, Dallas, Texas, 

for the design of the Creative Summit Announcement Poster. Designer with Hill Group.
▸ Award of Excellence, Dallas Society of Visual Communications, a regional design competition, Dallas, 

Texas, for the design of the Creative Summit Poster series. Designer with Hill Group.
▸ Award of Excellence, Council for Advancement and Support of Education, Southwest, a regional design 

competition, for the design of the Creative Summit 10th anniversary poster.  
Designer with Hill Group.

▸ Award of Excellence, Council for Advancement and Support of Education, Southwest, a  
regional design competition, for the design of the Creative Summit Poster series.  
Designer with Hill Group.

1993
▸ Bronze Medal, Austin Graphic ArtS Society, a regional design competition, Austin Texas.  

Creative Summit 10th anniversary poster. Designer with Hill Group.
▸ Award of Excellence, Austin Graphic ArtS Society, a regional design competition, Austin Texas. Creative 

Summit 10th anniversary poster. Designer with Hill Group.

1992



▸ Gold Medal, Savannah Advertising Federation, a regional advertising design competition, Savannah,Georgia, 
for the design of the Willingway Hospital four color advertisement series.

▸ Gold Medal, Little Rock Advertising Federation, a regional advertising design competition, Little Rock, 
Arkansas, for the design of the Nickelodean Network Regional outdoor campaign Commission through Stone 
Ward Advertising.

▸ Gold Medal, Little Rock Advertising Federation, a regional advertising design competition,  
Little Rock, Arkansas, for the design of Winrock International exhibition display.

▸ Gold Medal, Little Rock Advertising Federation, a regional advertising design competition,  
Little Rock, Arkansas, for the design of the Little Rock Convention Center bus exterior. 

▸ Bronze Medal, Healthcare Marketing Report Awards, a regional advertising design competition, Atlanta, 
Georgia, for the design of the Willingway Hospital four color calender. 

EXHIBITIONS

Texas A&M University–Corpus Christi

2023 
▸  Human Rights Art Exhibition. College of the Sequoias, CA. (March 7–29) Juried, International  

Piece Exhibited: No Wall No Ban
▸  2022 New Impressions Exhibition (traveling show). MICA, Baltimore, MD. (February 10–March 4) 

Piece Exhibited: Your Vote Matters
▸  La Merienda Fine Art Show and Sale. Weil Gallery, Texas A&M University-Corpus Christi. (January 27) 

Juried, Regional  
Pieces0 Exhibited: The Smithville Papers: Number 11 and 14

2022
▸ 10th Annual International Juried Print Exhibition. Remarque/New Grounds Print Workshop & Gallery, 

Albuquerque, New Mexico. (December 2–January 28) Juried, International 
Pieces Exhibited: The Smithville Papers: Number 11

▸ 3rd Annual International FPG Print Exhibition. Fresno Printmakers’ Guild, Fresno, CA. (November 14–
December 31) Juried, International (Jurors: Sarah Marshall, Matthew Rangel, Jessica Robles) 
Pieces Exhibited: The Smithville Papers: Number 13, The Smithville Papers: Number 14, and Your Vote Matters

▸ Oso Bay Biennial XXII Printmaking Festival: Transmissions from Pressure Island. Produce Gallery, Corpus 
Christi, TX. (October) Invited, Regional 
Piece Exhibited: Your Vote Matters

Old Dominion University

2022 
▸  New Impressions 2022: An International Exhibition of Letterpress Printing. Hamilton Wood 

Type & Printing Museum, Two Rivers, WI. (April 8–June 30) Juried, International  
(Jurors: Richard Ardagh, Ben Blount and Sukhie Patel) 
Piece Exhibited: Your Vote Matters Poster

2021
▸ The Society of Typographic Arts. 2021 STA 100. Web (https://100.sta-chicago.org/winners/2021/

your-vote-matters)
  Pieces Exhibited: Your Vote Matters Poster
▸ WHATEVS. Art Fluent, Online Exhibitions. Web (https://www.art-fluent.com/whatevs)
  Pieces Exhibited: Climate Change in a HOAX

2020
▸ 2020 Posters of Discontent IV. Marygrove Gallery of Art, Detroit, Michigan. (Oct 23–Nov 9) 

Curated, International.  
Pieces Exhibited: No Wall No Ban, American Dream & HOAX

▸ New Impressions 2020: An International Exhibition of Letterpress Printing. Hamilton Wood Type & Printing 
Museum, Two Rivers, WI. (July 14–December 30) Juried, International (Jurors: Stephen Coles, Brenda 
McManus, and Claudio Rocha) 
Piece Exhibited: Americana Fest Poster

▸ PDLP: Post-Digital Letterpress Printing Conference. Faculty of Fine Arts of the University of Porto, Portugal. 



(Jan 30–31) Curated, International.  
Pieces Exhibited: The Smithville Papers: Numbers 3, 7 and 11

▸ New Impressions in American Letterpress (traveling show). Letterpress Hullabaloo 2020, Christel DeHaan 
Fine Arts Center Gallery, Indianapolis, IN. (Jan 21–Feb 07).  
Piece Exhibited: The Smithville Papers: Number 11

2019
▸ 2019 Creativity 49. Creativity Print & Packaging International Awards Annual. (September) Juried 

Competition, International. Exhibited on web. 
Piece exhibited: John Paul White Letterpress Poster

▸ The Society of Typographic Arts. 2019 STA 100. (October) Juried Competition, International (Judges: Ellen 
Lupton, Matthew Hoffman, Meriah Garrett, and Aarron Walter). Exhibited on web. 
Piece exhibited: No Wall No Ban Letterpress Poster

▸ Graphic Design USA. American Graphic Design Awards. (October) Juried Competition, National (Judges for 
this competition were not disclosed.)  
Piece exhibited: Americana Fest Letterpress Poster

▸ A Public Act: R-N-R Showprint. WPA Gallery, Norfolk, VA. (October 18–December 24) Curated, Solo Exhibition. 
Pieces Exhibited: Broadsides and Posters (letterpress and digital)

▸ New Impressions 2019: An International Exhibition of Letterpress Printing. Hamilton Wood Type & Printing 
Museum, Two Rivers, WI. (April 17–June 30) Juried, International (Jurors: Dafi Kühne, Mary Mashburn and 
Jessica Spring) 
Piece Exhibited: The Smithville Papers: Number 11 

2018
▸ 5th Louisiana Biennial: Art of the Poster Exhibition. Louisiana Tech University, Ruston, LA. (October 30–

December 04) Juried, National (Juror: Celene Aubry, Associate Director & Manager, Hatch Show Print) 
Pieces Exhibited: No Wall No Ban Broadside & War and Peace Poster

▸ Black & White Show. CORE New Art Space, Denver, CO. (July 12–29): Juried, International (Juror: Deanne 
Pytlinski, Ph.D.) 
Piece Exhibited: Climate Change is a HOAX!

▸ Graphic Design in Coastal Virginia Exhibition. The Charles H. Taylor ArtS Center, Hampton, VA. (June 23–
Aug 12): Curated, Regional 
Pieces Exhibited: What Motivates Us to Sing? Poster, 400 Years After Shakespeare Poster and the Cosi Fan 
Tutte Poster

▸ New Impressions: An International Exhibition of Letterpress Printing. Hamilton Wood Type & Printing 
Museum, Two Rivers, WI. (April 17–June 30): Juried, International. (Jurors: Macy Chadwick, principal, 
In Cahoots Press, Petaluma, CA; David Wolske, Assistant Professor of Communication Design in the 
Department of Design, College of Visual ArtS and Design, University of North Texas; Richard Zauft, Dean of 
the Lesley University College of Art and Design in Cambridge, Massachusetts) 
Piece Exhibited: FYT No Wall No Ban

2017
▸ Printwork 2017. AIR: Artists Image Resource, Pittsburg, PA (Dec 8– Feb 4): Juried, National. Juror: Joseph 

Lupo.  
Piece Exhibited: FYT No Wall No Ban

▸ RESIST: Re-Invigorate and Express Your Views, Thoughts and Concerns. Zenith Gallery, 
Washington DC, USA. (July 13–Sept 1) Juried, National 
Pieces Exhibited: Three broadsides: Right is Right, No Wall No Ban, and Climate Change HOAX! 

▸ RESIST: Re-Invigorate and Express Your Views, Thoughts and Concerns (traveling show). 
Busboys and Poets (Takoma), Washington DC, USA. (July 15–Oct 15) 
Pieces Exhibited: Three broadsides: Right is Right, No Wall No Ban, and Climate Change HOAX!

▸ New Impressions in American Letterpress (traveling show). NERAM (New England Regional 
Art Museum), Armadale, New South Wales, Australia. (Feb 11–Apr 30) 
Piece Exhibited: The Smithville Papers: Number 7

2016
▸ New Waves 2016. Virginia MOCA. Virginia Beach, VA (Jan 29–Apr 17): Juried, Regional 

» Piece Exhibiting: Washington DC Poster



▸  New Impressions in American Letterpress (traveling show). Design College Australia, 
Brisbane. (Aug 9–21) 
» Piece Exhibited: The Smithville Papers: Number 7

▸   New Impressions in American Letterpress. Hamilton Wood Type & Printing Museum, Two 
Rivers, WI. (May 11–June 30): Juried, International (Jurors: Paul Brown, professor of Graphic 
Design at Indiana University, Amelia Hugill-Fontanel, associate curator at the Cary Graphic 
ArtS Collection at Rochester Institute of Technology and Jim Sherraden, Master Printer, 
Chief Designer and Archivist at Hatch Show Print) 
» Piece Exhibited: The Smithville Papers: Number 7

▸    Artist Who Teach. The Charles H. Taylor ArtS Center. Hampton, VA (Mar 19–May 1): Curated, Regional 
» Pieces Exhibited: The Smithville Papers: Numbers 7 & 8

2015
▸ Old Dominion University. The Baron and Ellin Gordon Art Galleries. Department of Art Faculty Exhibition 

(Aug 28–Oct 11): Curated, Local 
Pieces Exhibiting: The Smithville Papers: Numbers 1-6

▸ Graphics Month Charge. Hanbury Evans Wright Vlattas + Company, Norfolk, VA. (July 1–August 1): Curated, Local 
Pieces Exhibited: The Smithville Papers: Numbers 1-5; RNR Dry-bys 1 & 2 

▸ New Impressions in American Letterpress. Hamilton Wood Type & Printing Museum, Two Rivers, WI. (May 
16–June 30): Juried, National (Juror: Tracy Honn, Silver Buckle Press) 
Piece Exhibited: The Smithville Papers: Number 3

▸ Signs of the Times. Contemporary Broadside National Juried Exhibition. NDSU Flakoll Gallery, Fargo, ND. 
(March 11–April 3): Juried, National (Juror: Stephen Frech, Oneiros Press) 
Pieces Exhibited: The Smithville Papers: Number 3, The Smithville Papers: Number 4 
Honorary Merit Award: The Smithville Papers: Number 3 (1 of 6 awarded recipients)

▸ What a Relief! Exhibition featuring work from Hatch Showprint and R-N-R Showprint. Visual ArtS Center. 
Portsmouth, VA. (Jan 17–March 5): Curated, Regional 
Pieces Exhibited: Craig Crutchfield Letterpress Poster, The New York Field Trip Poster, Hatch Showprint 
Poster, First Friday Field Trip Poster (2 pieces), Gary Simmons Visiting Artist Poster, Enjoy: Holiday Card, 
Philadelphia Field Trip Poster, Washington DC Field Trip, Cosi Fan Tutte Poster, 1&1 Make 50 Invitation, 
Thank U! Card, A Taste of Mozart Poster, The Smithville Papers (4 pieces)

2014
▸ HOW Design Live. Boston, MA, USA. Creativity 43 Traveling Winner’s Exhibit. (May 12–16) 

This traveling exhibit showcases only the Best in Show, Platinum, and Gold winners from the 43rd Creativity 
International Awards Annual.

Winning entry: Hatch Showprint Lecture Poster
▸ Phoenix Design Week. Phoenix Convention Center, Phoenix, AZ. (October 17–24)
This traveling exhibit showcases only the Best in Show, Platinum, and Gold winners from the 43rd Creativity 

International Awards Annual.
Winning entry: Hatch Showprint Lecture Poster
▸ Shooting Star Gallery. The Art and Craft of Letterpress. Suffolk, VA. (Jan 25–March 10):  

Curated, Regional 

2013
College of the Albemarle Professional ArtS Gallery. Three Printmakers. Manteo, NC. (Oct 16–Nov 21): Curated, 

Regional

Texas State University–San Marcos
All the listings above in the Awards section for the Dallas Society of Visual Communications, the Austin and 

San Antonio Graphic ArtS Associations, the Austin and San Antonio Addys, and The Art Directors Club of 
Houston included exhibition at the awards events.

▸ 2000 Art Books, The Urban Institute for Contemporary Arts, Grand Rapids, Michigan. Included the book 
Catfish Hens.

▸ 1999 Type Directors Club of New York Annual Show. Toured the United States, Canada, Europe, Southeast 
Asia, Japan, Mexico, Australia, and South America. Included the book Catfish Hens.

▸ 1999 International Bienale of Graphic Design Brno 2000, Moravian Gallery, Brno, Czech Republic. 
International exhibition of graphic design included the book Catfish Hens.



COLLECTIONS (SELECTED)

Old Dominion University

2017
▸ Rare Book and Manuscript Library  

Butler Library, Columbia University, New York, NY

2016
▸ Hamilton Wood Type and Printing Museum. Two Rivers, WI

2015
▸ Hamilton Wood Type and Printing Museum. Two Rivers, WI 

Texas State University-San Marcos
▸ Library, The Tate Gallery, London, England
▸ Library, National Gallery of Scotland, Edinburgh, Scotland 
▸ Library, Irish Museum of Modern Art, Dublin, Ireland 
▸ Library, Klingspor Museum, Offenbach, Germany
▸ Library, Stedelijk Museum of Modern Art, Amsterdam, Holland 
▸ Library, Guggenheim Museum, Bilbao, Bilbao, Spain
▸ Library, Museum fur Moderne Kunst, Frankfurt, Germany 
▸ Library, Museum of Contemporary Art, Tokyo, Japan 
▸ Thomas J. Watson Library, Metropolitan Museum of Art, New York, NY
▸ Library, Museum of Modern Art, New York, NY
▸ Library, Whitney Museum of American Art, New York, NY
▸ Library, Corcoran Gallery of Art, Washington, D.C
▸ Library, Dallas Museum of Art, Dallas, TX
▸ Library, Solomon R. Guggenheim Museum, New York, NY
▸ Walker Art Center Library, Minneapolis, MN
▸ Allan C. Balch Art Research Library, Los Angeles County Museum of Art, Los Angeles, CA
▸ Ryerson and Burnham Libraries, Art Institute of Chicago, Chicago, IL
▸ Austin Museum of Art, Austin, TX
▸ Blanton Museum of Art, University of Texas, Austin, Austin, TX
▸ Klingspor Museum, Offenbach, Germany
▸ Nelson-Atkins Museum of Art, Kansas City, MO
▸ Museum of Modern Art, Oxford, Oxford, England
▸ San Jose Museum of Art, San Jose, CA
▸ San Francisco Museum of Modern Art, San Francisco, CA
▸ Southern Alleghenies Museum of Art, Loretto, PA

PROFESSIONAL DEVELOPMENT

INVITED TALKS, LECTURES, PRESENTATIONS, WORKSHOP, EVENTS ATTENDED

Texas A&M University–Corpus Christi
Fall 2022 –Spring 2023 
▸ ACUE Effective Online Teaching Practices Course at TAMU-CC: In-progress
▸ Online Course and Design Workshop

Old Dominion University
2015 Invited lecturer, Tidewater Community College, Portsmouth, VA.  

Presented a 45 minute lecture, “We don’t eat our young”, and Q&A to approximately 60 students and faculty.
2015 Invited lecturer, Visiting Artist Lecture, Visual ArtS Center. Portsmouth, VA 

Presented a 30 minute lecture on the history of letterpress printing as well as the design and printing processes 
of R-N-R Showprint. Presenter, with Ivanete Blanco.

2004 Reviewer, Louisiana Tech University, Ruston, LA. Principal reviewer at a three day senior portfolio 
review.

2000 Instructor, Louisiana Tech University, Ruston, LA. Led a three day seminar in book design.
1998 Instructor, Louisiana Tech University, Ruston, LA. Led a three day seminar in non-adhesive bookbinding.
1996 Presenter, Art on Campus, Texas State Department of Art & Design. Presented a lecture on “The future of 



multimedia.”
1993 Instructor, Louisiana Tech University, Ruston, LA. Led a two day seminar on digital illustration.
1995 Co-organizer, The Creative Summit.
1994 Co-organizer, The Creative Summit.
1993 Co-organizer, The Creative Summit.

CONFERENCES AND PRESENTATIONS

Old Dominion University

2019
Attended The Richmond Show. Advertising Club of Richmond. Richmond, VA
Attended AIGA Hampton Roads. Insight: Student Portfolio Review 2019. Norfolk, VA

2018 
Attended American Advertising Awards Gala. American Advertising Federation: Hampton Roads.
Virginia Beach, VA
Attended AIGA Hampton Roads. Insight: Student Portfolio Review 2018. Norfolk, VA

2017 
Attended ODU Art Department & AIGA Hampton Roads. Screening of Pressing On: The Letterpress.
Attended AIGA Hampton Roads. Nikki Villigomez: 10 Things I’ve Learned by Working Hard and Being Ballsy. 

Lecture for ODU students. Norfolk, VA
Attended AIGA Hampton Roads. Nikki Villigomez: How Culture Affects Typography. Norfolk, VA Film and 

Q&A with filmaker and designer Erin Beckloff. Norfolk, VA Attended AIGA Hampton Roads. Community 
Meeting at Percolator. Norfolk, VA

Attended AIGA Hampton Roads. The Happy Film screening at the Slover Library. Norfolk, VA
Attended The Richmond Show. Advertising Club of Richmond. Richmond, VA
Attended AIGA Hampton Roads. Aaron Draplin: Pretty Much Everything. Virginia Beach, VA

2016 
Attended AIGA Hampton Roads. Bob Ewing: Always be Learning. Norfolk, VA
Attended AIGA Hampton Roads. Making Fun Things is Serious Business with Armin Vit. Virginia Beach, VA

2015
Attended American Advertising Awards Gala. American Advertising Federation: Hampton Roads. Norfolk, VA. 

Attended with ODU student award winners.
Attended lecture,AIGA Hampton Roads, The Prince Ink Company and MOCA. James Edmondson: Fonts are 

Forever Lecture. Virginia Beach, VA.

2013–2014
Spring 2014
Attended AIGA Hampton Roads: Shred, Skateboard Art Show. Norfolk, Virginia
Attended AIGA Hampton Roads: Lecture: Joe DiGioia: Change by Design. Norfolk, Virginia
Attended AIGA Hampton Roads: Lecture: Dean Browell: Social Media Trends. Norfolk, Virginia
Attended AAF Hampton Roads, American Advertising Awards Gala. Attended with ODU student award 

winners.
Fall 2013
Attended AIGA Hampton Roads: Kern & Burn. Norfolk, Virginia

Texas State University–San Marcos
2011 Attended three day Wayzgoose Conference, Hamilton Wood Type, Two Rivers, WI.
1998 Attended two day conference of the Association of Graphic Design Educators.
1997 Participated in live, interactive videoconference, “The New Public University.”
1996 Attended South-by-Southwest/Microsoft multimedia conference, Austin, TX.
1995 Attended South-by-Southwest multimedia conference, Austin, TX.
1994 
▸ Attended two workshops in Interactive multimedia at Liason Productions, Austin, TX.
▸ Attended two day conference of the Association of Graphic Design Educators.
▸ Attended two day computer imaging seminar at Liason productions, Austin, TX.
1993 
▸ Participated in a conference of Texas college and university level educators as part of the Creative Summit.



▸ Attended an eight hour “Power User” seminar on Adobe Photoshop and prepress applications presented by 
Liason productions of Austin, TX.

1992
▸ Attended the Texas Chapter of the AIGA Annual Computer Conference held at the Infomart, Dallas, TX.
▸ 1992 Attended afternoon computer imaging seminar at University of Texas, Austin, TX.

GRANTS
▸ 2003 Research enhancement grant, TXST, with Professor Mark Todd 

To design and produce the book, Possum Box.
▸ 2001 Research enhancement grant, TXST, with Professor Mark Todd 

To design and produce the book Ashe Motors.
▸ 1998 Research enhancement grant, TXST, with Professor Mark Todd 

To design and produce the book Catfish Hens.
▸ 1995 Research enhancement grant, TXST.  

To further research for the electronic book Ligatures.

SERVICE

UNIVERSITY | COLLEGE 

Texas A&M University–Corpus Christi

Committees 

2022–2023
▸ Representative, SAMC Graduate Council

DEPARTMENT

2022–2023

Committees
▸ Member, Department of Art and Design Sculpture Search Committee

Other
10/15/22 Island Days

Old Dominion University

Committees

2013–2022
▸ College Technology and Computer Resources Committee: Member

Texas State University–San Marcos

2007–2012
▸ Chair and member, College Scholarship committee

2010
▸ Member, School of Art and Design Director Search Committee

2007–2008 
▸ Chair and member, Academic Standards Committee

2007
▸ Member, Faculty Senate

1996–1998 
▸ Co-organizer, The Creative Summit, a three-day student design conference and competition. 

The Summit brought together students from a five-state region and the best American designers, art directors, 
illustrators, photographers, and new digital specialists on the TXST campus. My primary role was on-campus 
logistics, coordination of presenters and supervision of the student design competition.

1996–1997
▸ Chair, University Academic Computing Committee

1995–1997
▸ Faculty mentor, TXST mentoring program

1997–1999



▸ Thesis advisor, University Honors Program

SCHOOL | PROGRAM

Old Dominion University

2017–2018
▸ Technology committee: chair
▸ Represented department during Admitted Students Day event

2016–2017
▸ Technology committee: chair
▸ Instructional tech search committee: member (2 searches)
▸ Represented department during Admitted Students Day event
▸ Represented department during Scholar’s Day event
▸ Represented department during GSA Art School Fair 
▸ Represented department during groundbreaking ceremony of the Barry Art Museum

2015

Committees
▸ Curriculum committee: member
▸ Gallery committee: member

2013–14
▸ Student show committee: member

Texas State University–San Marcos
As stated above, I was intensely involved in service to the program and the School of Art and Design (a 

department at the time of my arrival) since my first year at TXST. Those listed immediately below represent 
significant and/or long-term activities or accomplishments.  
Please see the end of this section for a list of the tasks which were a routine part of my program service. 

1999–2002 | 2005–2008
▸ ComDes area coordinator 

I coordinated budgeting, purchasing, course scheduling, curriculum development, technology acquisition and 
management, and both full-time and adjunct recruitment, hiring, evaluation, orientation, and training.

1997–1998 | 2002–2004 | 2009–2010
▸ ComDes area c0-coordinator 

I coordinated course scheduling, curriculum development, technology acquisition and management, and 
adjunct recruitment, orientation, and training.

1993–1996
▸ Prior to the implementation of the Area Coordinator system, I shared the responsibility for all aspects of 

program administration, planning, hiring, scheduling, curriculum development, purchasing, technology 
acquisition and management and new initiatives.

1998–1999
▸ Member, Department of Art and Design governance committee 

I was a part of the small team which rewrote the department’s governance structure, creating the current area 
coordinator system.

2007–2009
▸ ComDes co-counsel to Director of the School of Art and Design 

I worked with the director to identify curricular and enrollment issues and propose new policies and 
procedures.

1995–1996
▸ With Assistant Professor William Meek, negotiated an Apple Max Lease Agreement. The first arrangement of 

it’s kind on a Texas campus, the agreement provided essential computing hardware and a system for regular 
upgrade.

1996–2003
▸ ComDes representative, Department of Art & Design ATP Facility Committee. 



I was the ComDes coordinator throughout the process of the construction, and relocation to, the J.C. Mitte 
facility. I led a rotating group of ComDes faculty in the research and development, design, planning, and 
purchasing for the new facility, and coordinated the relocation of all offices and classrooms.

1999–2012
▸ Coordinator, ComDes Senior Exit Review 

All TXST ComDes majors are required to display their final portfolios at this biannual event. The event consists 
of both a closed review for faculty and professionals and an open review for family, friends, and guests. I 
established and supervised all aspects of this event (initial planning, to promotion, to coordination with 
agencies and studios) for an average of 65 students per semester. Of the 28 events held since 1999, I participated 
in 25 and coordinated 22.

1992–1997
▸ Managed ComDes Imaging Lab including: coordinating lab student workers, provided primary systems 

support, provided primary research for all software and hardware purchased for the Imaging Lab, coordinated 
all hardware repair and purchasing, managed all software updates. During this period the program’s 
computing resources increased from 18 to 40+ workstations.

1993–1998 | 2007–2012
▸ Member then Chair, School of Art and Design scholarship committee

2007–2012
▸ Coordinater, ComDes outcomes assessment 

I authored the outcomes document, created the assessment instrument, and coordinated the assessment 
process during Exit Review.

2000–2001
▸ Chair, Department of Art & Design Hiring committee 

Organized and facilitated all aspects of the ComDes search for two full-time tenure-track positions. Resulted 
in the hiring of one tenure track faculty, and one yearly full-time faculty.

1999–2000
▸ Chair, Department of Art & Design Hiring committee 

Organized and facilitated all aspects of the ComDes search for one full-time tenure-track position. Resulted in 
the hiring of one tenure track faculty.

1995 | 1996 | 1997 | 1998 | 2007
▸ Chair of ComDes Hiring committees 

Resulted in the hiring on two tenure-track faculty and two yearly contract faculty, one of which has since 
transitioned to tenure-track. The 2007 search resulted in the first tenure-track hire for the newly-created M.F.A. 
program in ComDes.

2010–2012
▸ Coordinated the creation of the third floor letterpress area. I coordinated the acquisition and restoration of the 

proofing press, the renovation of the space, and the first donation of type. 

2010–2012
▸ Coordinated construction of the ComDes production studio.

2003–2010
▸ Faculty representative to 502, a ComDes Alumni Organization 

502 was an independent organization devoted to the advancement of the program and its graduates. I facilitated 
the founding of the group and assisted in their efforts to raise scholarship funds, provide resources to current 
students, and to build community amongst our alumni. During its existence the group distributed over $15,000 
in materials and scholarships and provided a vital path to professional practice for hundreds of students.

1994–2002
▸ Founder and advisor to the Association of Student Communication Designers

1998–2001
▸ Supervisor to the Departmental Microcomputer Lab Coordinator

1997 
▸ Chair, Department of Art & Design hiring committee for part-time teaching pool
▸ Chair, Department of Art & Design hiring committee for Microcomputer Lab Coordinator



2007–2012
▸ Member, School of Art and Design promotion and tenure document committee 

During my time on this committee, we undertook the first extensive rewrite of the tenure and promotion 
document since the early 1980s in an effort to better coordinate with the larger university effort to consolidate 
T&P documents and better advise tenure-track faculty.

2008–2010
▸ Member, School of Art and Design mentoring committee 

2007–2010
▸ Member, School of Art and Design faculty mentorship committee

2005–2010
▸ Coordinator, ComDes “Third Floor” gallery space.

1999
▸ Chair, Department of Art & Design hiring committee for part-time teaching pool
▸ Co-author, ComDes self-study report

1995–2003
▸ Chair and member, Department of Art & Design facilities committee

2001–2003
▸ Member, Department of Art & Design curriculum committee

2001–2003
▸ Chairand member, Department of Art & Design visual resources center committee

1997–2007
▸ Advisor to the Texas State student chapter of the AIGA

1998–2001
▸ Coordinated all aspects of the acquisition and renovation of two new, the first created since the establishment 

of the program in the early 1980s.

1998–2011 
▸ Authored and edited the ComDes creative standards and policies handbook

1997 
▸ Chair and member, Department of Art and Design foundations committee

1996 
▸ Coordinated the renovation of the ComDes design studio.
▸ Prepared ComDes technology strategy and purchasing proposal.

1993 
▸ Established the Student Interactive Multimedia Publications Group.

1992
▸ Established the Imaging Studio | Multimedia Workspace.  

I coordinated renovation of the space and secured an internal technology grant for the purchase of 
workstations.

 (routine activities)
The following activities represent my every-day service to the program throughout my time at Texas State.
▸ Coordinater of ComDes teaching spaces and production labs
▸ Contact for freelance opportunities for ComDes majors
▸ Superviser of ComDes student assistants and lab monitors
▸ Recruiting contact for prospective students and their parents
▸ Extra-curricular workshops coordinator
▸ Supervisor of the letterpress area

Other service to the department or program

Old Dominion University

2021



▸ Coordinator: Graphic Design internship program
▸ Designer, administrator and evaluator: Graphic Design Continuance Review Test of Skills Component
▸ Advisor: Graphic Design Majors (advised approximately 50 majors)  

Offered an all-day walk-in advising session for majors in addition to scheduled appointments.
▸ Maintained and supervised Graphic Design Production Rooms. Provided instruction for all Graphic Design 

students in the use of equipment.
▸ With Ivanete Blanco, edited and Graphic Design web page and curriculum page.
▸ Assisted Ivanete Blanco in update of the Graphic Design curriculum map and assessment form.

2020
▸ Coordinator: Graphic Design internship program
▸ Designer, administrator and evaluator: Graphic Design Continuance Review Test of Skills Component
▸ Advisor: Graphic Design Majors (advised approximately 50 majors)  

Offered an all-day walk-in advising session for majors in addition to scheduled appointments.
▸ Maintained and supervised Graphic Design Production Rooms. Provided instruction for all Graphic Design 

students in the use of equipment.
▸ Designed and produced promotional materials for the Graphic Deisgn program to be distributed at recruiting 

events. 
▸ With Ivanete Blanco, edited and Graphic Design web page and curriculum page.
▸ Assisted Ivanete Blanco in update of the Graphic Design curriculum map and assessment form.

2019
▸ Coordinator: Graphic Design internship program (Spring)
▸ Designer, administrator and evaluator: Graphic Design Continuance Review Test of Skills Component
▸ Advisor: Graphic Design Majors (advised approximately 50 majors)  

Offered an all-day walk-in advising session for majors in addition to scheduled appointments.
▸ Maintained and supervised Graphic Design Production Rooms. Provided instruction for all Graphic Design 

students in the use of equipment.
▸ Designed and produced promotional materials for the Graphic Deisgn program to be distributed at recruiting 

events. 
▸ With Ivanete Blanco, edited and Graphic Design web page and curriculum page.

2018
▸ Coordinator: Graphic Design internship program (Spring)
▸ Coordinator: Graphic Design Continuance Review
▸ Participated in the Art Department Team Building retreat
▸ Designer, administrator and evaluator: Graphic Design Continuance Review Test of Skills Component
▸ Advisor: Graphic Design Majors (advised approximately 50 majors)  

Offered an all-day walk-in advising session for majors in addition to scheduled appointments.
▸ Maintained and supervised Graphic Design Production Rooms. Provided instruction for all Graphic Design 

students in the use of equipment.
▸ Designed and produced promotional materials for the Graphic Deisgn program to be distributed at recruiting 

events. 
▸ With Ivanete Blanco, edited and Graphic Design web page and curriculum page.
▸ With Ivanete Blanco, edited and redesigned Graphic Design curriculum worksheet then met and coordinated 

with college advisors to roll-out.
▸ Assisted Ivanete Blanco in development of the Graphic Design curriculum map and assessment form.

2018 Service to AIGA student group:
▸  Attended and presented to printing processes workshop
▸ Presented workshop: 2017 Test of skills revisited (Illustrator, Photoshop and InDesign tutorials)

2017
▸ Coordinator: Graphic Design internship program (Fall)
▸ Coordinator: Graphic Design Continuance Review
▸ Participated in the Fall 2017 Art Department retreat
▸ Designer, administrator and evaluator: Graphic Design Continuance Review Test of Skills Component
▸ Advisor: Graphic Design Majors (advised approximately 70 majors)  

Offered an all-day walk-in advising session for majors in addition to scheduled appointments.



▸ Maintained and supervised Graphic Design Production Rooms. Provided instruction for all Graphic Design 
students in the use of equipment.

▸ Designed and produced promotional materials for the Graphic Deisgn program to be distributed at recruiting 
events. 

▸ Facilitated participation in required senior Exit Review for all graduating seniors.
▸ With Ivanete Blanco, edited and redesigned Graphic Design landing web page and curriculum page.
▸ With Ivanete Blanco, met and edited and redesigned Graphic Design curriculum worksheet then met and 

coordinated with college advisors to roll-out.
▸ Assisted Ivanete Blanco in development of the Graphic Design curriculum map and assessment form.

2017 Service to AIGA student group:
▸  Attended lecture, How Culture Affects Typography, by designer Nikki Villagomez with students
▸ Attended lecture, 10 Things I’ve Learned by Working Hard and Being Ballsy, by designer Nikki Villagomez 

with students
▸ Attended, Eat and Greet welcome event for new and returning students.
▸ Attended studio tour of Red Chaulk Studios with students

2016
▸ Participated in the Fall 2016 Art Department retreat
▸ Throughout Spring and summer, assisted in the cataloging and aquisition of letterpress equipment and type 

fonts for addition to the ODU letterpress collection from the Coastland Times Co., Manteo, NC.
▸ Advisor: Graphic Design Majors (advised 25 majors)
▸ Maintained and supervised Graphic Design Production Rooms.

2016 Service to AIGA student group:
▸ Presented workshop: 2016 Test of skills revisited (Illustrator, Photoshop and InDesign tutorials)
▸ Co-organizer, Mohawk Paper School. Presenter Mohawk paper representative Brian Sagula.
▸ Co-organizer, campus and classroom visits as well as presentation and Q&A by alumni and Dallas area 

designer, Elijah Stewart.
▸ Co-organizer, Eat and Greet welcome event for new and returning students.
▸ Attended El Chow luncheon

2015
▸ Administrator and designer: Graphic Design Continuance Review Test of Skills Component
▸ Advisor: Graphic Design Majors
▸ Reviewer: Studio Art Portfolio Continuance Review
▸ Superviser: Graphic Design Production Rooms. 
▸ Art Department representative: ODU admitted students day.
▸ Assisted in the relocation of the graphic design program to the Hixon ArtS Building: assisted in planning for 

mediation and arrangement of the rooms, as well as purchasing and installation of furnishings and equipment, 
including the installation of the magnetic markerboard system.

2015 Service to AIGA student group:
▸ Presented workshop: 2015 Test of skills revisited (Illustrator, Photoshop and InDesign tutorials)
▸ Presented workshop: Portfolio Crash Course
▸ Attended El Chow luncheon

2014
▸ Advisor: Graphic Design Majors
▸ Organizer, Mohawk Paper School. Presenter Mohawk paper representative Brian Sagula. An informational 

meeting for students concerning commercial paper manufacturing and uses.
▸ Organizer, GDODU Darn Near Everything meeting and Eat and Greet. An information meeting for all 

students enrolled in or intending to enroll in the graphic design concentration.
▸ Studio continuance portfolio reviewer 
▸ Graphic design continuance portfolio reviewer
▸ Graphic design continuance review Test of Skills, designer and administrator
▸ Graphic design work room equipment supervisor. Maintain, order, clean, and coordinate purchase and repair 

of equipment, as well as supervising students using the space.
▸ Attended departmental Technology Committee meetings



▸ Assisted in the relocation of the graphic design program to the Barry ArtS Building: assisted in planning for 
mediation and arrangement of the rooms, as well as purchasing and installation of furnishings and equipment, 
including the installation of the magnetic markerboard system.

2014 Service to AIGA student group:
▸ Presented workshop: Advanced InDesign
▸ Presented workshop: Basic InDesign
▸ Attended El Chow luncheon

2013
▸ Studio continuance portfolio reviewer 
▸ Graphic design continuance portfolio reviewer
▸ Graphic design work room equipment supervisor. Maintain, order, clean, and coordinate purchase and repair 

of equipment, as well as supervising students using the space.
▸ Attended departmental Technology Committee meetings

2013 Service to AIGA student group:
▸ Presented workshop: Advanced InDesign
▸ Presented workshop: Basic InDesign
▸ Attended El Chow luncheon
▸ Assisted in organization of professional Q&A panel event.
▸ Assisted in the relocation of the graphic design program to the Barry ArtS Building: assisted in planning for 

mediation and arrangement of the rooms, as well as purchasing and installation of furnishings and equipment, 
including the installation of the magnetic markerboard system.

2012
▸ Assisted in 3 hour workshop and presentation by visiting artist Jim Sherraden (Hatch Showprint).
▸ Led a 3 hour workshop covering advanced techniques in Adobe InDesign CS 6 through the student chapter of 

Hampton Roads AIGA for Art students.
▸ Attended El Chow luncheon hosted by the student chapter of Hampton Roads AIGA for Art students.
▸ Reviewer: Graphic Design Continuance Portfolio Review
▸ Reviewer: Graphic Design Exit Portfolio Review
▸ With Ivanete Blanco, established new Graphic Design production room. Maintained room and equipment.

PROFESSIONAL

Old Dominion University

2018–21 
Member of TCC’s Visual Arts Center Advisory Board. Portsmouth, Virginia

2021
▸ Reviewer: Tidewater Community College senior portfolio review. Fall
▸ Judge and coordinator: Great Computer Challenge 2020, Senior Division.

2020
▸ Judge and coordinator: Great Computer Challenge 2020, Senior Division.
▸ Reviewer: Tidewater Community College senior portfolio review. Fall and Spring

2019
▸ Judge and coordinator: Great Computer Challenge 2019, Senior Division.
▸ Reviewer: Tidewater Community College senior portfolio review. Fall and Spring

2018
▸ Judge and coordinator: Great Computer Challenge 2018, Senior Division.
▸ Reviewer: Tidewater Community College senior portfolio review. Fall and Spring

2017
▸ Judge and coordinator: Great Computer Challenge 2017, Senior Division. ▸ Reviewer: Tidewater Community 

College senior portfolio review. Fall and Spring

2016
▸ Judge and coordinator: Great Computer Challenge 2016, Senior Division. 
▸ Reviewer: Tidewater Community College senior portfolio review. Fall and Spring



2015
▸ Judge: Great Computer Challenge 2015, Senior Division.
▸ Reviewer: Tidewater Community College senior portfolio review.

2014
▸ Judge: Great Computer Challenge 2014, Senior Division.
▸ Volunteer: AIGA Hampton Roads: Shred, Skateboard Art Show. Norfolk, Virginia
▸ Reviewer: Graphic Design Midway Portfolio Review sponsored by AIGA Hampton Roads.
▸ Reviewer: Tidewater Community College senior portfolio review.

Texas State University–San Marcos

2001 
▸ Tenure process reviewer, University of South Alabama, Department of Visual Arts

2000 
▸ Tenure process reviewer, Southern Mississippi University, Department of Art and Design

2003–2010
Faculty representative to 502, a ComDes Alumni Organization

COMMUNITY

2005–2022
▸ Vista Trail committee, LOVIT, and The Friends of Lake Ouachita (as mentioned above).  

The Lake Ouachita Vista Hiking and Biking Trail runs nearly 50 miles along the shores of the lake and through 
the Ouachita mountains, andprovides vital year-round tourism in the some of the most impoverished counties 
in the state. With the exception of the trail didactic program, my work associated with the trail is undertaken 
pro bono.

2006
▸ Habitat for Humanity, Wimberley, TX and Little Rock, AR 

Design of collateral materials and promotions for 2006 fundraising.

2005
▸ Habitat for Humanity, Wimberley, TX 

Design of collateral materials and promotions for 2005 fundraising,

1999–2001
▸ Organized ComDes Alumni event in conjunction with the Creative Summit Student Conference. Over three 

years, the luncheons raised roughly $5000 in scholarships and materials.

2000
▸ Food for thought, Central Texas Inc. 

Design of promotional materials for annual fundraiser. Designer, with Holly Sterling

1997–1998
▸ Greenhouse Theatre 

Design of fundraising materials. Organized in cooperation with the Association of Student Designers.

1998
▸ The Emilyann Theatre 

Design of fundraising materials.


